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This Help system includes topics that you can call directly from the GENIE Program. To get 
context-sensitive help, press the Help button in the window of your choice.    



The Index contains a list of all Help topics available for the Advantech GENIE Program. For 
information on how to use Help,    choose Using Help from the Help menu.



File menu commands

The File menu includes commands that enable you to open, close, save, and print new or 
existing GENIE Strategy Files. 

The File menu offers the following commands:

New Creates a new strategy.
Open Opens an existing strategy.
Close Closes an opened strategy.
Save Saves an opened strategy using the same file name.
Save As Saves an opened strategy to a specified file name.
Attach Bitmap Attach a bitmap file to be a background of your display.
Detach Bitmap Takes off displays background bitmap.
Print Prints a strategy.
Print Preview Displays the strategy on the screen as it would appear printed.
Print Setup Selects a printer and printer connection.
Exit Exits GENIE.



Edit menu commands

The Edit menu includes commands that enable you to edit items in your GENIE Strategy. To 
use Edit commands, you must first "grab" or select the items you wish to copy by pointing 
your mouse somewhere outside the group of items you wish to select. Press the left mouse 
button, and as you hold down the button, drag the pointer diagonally across the items you 
wish to copy. You will see a box form around the items. When the box is around the desired 
items, let go of the mouse button. When items are selected properly, there will be heavy 
black squares at the corners of all selected items. Now you can perform commands on 
selected items. 

To Move Selected Items:
To move one or many selected items in the GENIE Strategy Editor, press the left mouse 
button as you point to one of the selected items. As you hold down the left button, drag the 
selected items to the desired location, and let go of the mouse button when the location is 
reached.

To Delete Selected items:
Press the "Delete" key on the keyboard. A message will be displayed "Delete Selected 
Item(s)?" Press OK with your mouse, and the selected items will be deleted. There is also a 
"Delete" command    in the Edit menu that performs the same task on selected items. See 
below.

The Edit menu offers the following commands:

Cut Deletes data from the strategy and moves it to the clipboard.
Copy Copies data from the strategy to the clipboard.
Paste Pastes data from the clipboard into the strategy.
Select All Selects every item in the current strategy.

Setup Menu

The Setup menu includes commands that enable you to install, add, or remove an I/O 
device, and also to assign the Strategy to a particular Task. Commands are as follows:

Task
Runtime_Preference
Change-Passwod
Administration
Network
Devices
Addtool

View menu commands

The View menu includes commands that enable you to zoom to fit the screen, changing the 
view of selected items in the GENIE Strategy. The View Menu also enables the toolbar, 
toolbox, and status bar      to be displayed when in a Strategy Editor Window, show the labels 
under each icon block, or to show the grid when in a Display Window (Show Grid). 
Commands are:

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.



Toolbox Shows or hides the toolbox.
Zoom to fit Examines your strategy from afar.

Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple 
views of multiple strategys in the application window:

New Window Creates a new window that views the same strategy.
Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.
Arrange Icons Arranges icons of closed windows.
Window 1, 2, ... Goes to specified window.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

Index Offers you an index to topics on which you can get 
help.

Using Help Provides general instructions on using help.
About Displays the version number of this application.



New command (File menu)

Use this command to start a New strategy. During or after you create a strategy, you can 
save the strategy by using the Save As command.

Add Task (Supported under GENIE Plus)
Use this command to add a task. Under the standard version, only one task can be created.   
In GENIE Plus you can design multiple tasks, and can toggle between the tasks during 
runtime.

You can open an existing strategy with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



Open command (File menu)

Use this command to Open an existing strategy. Normally, existing strategies will be stored 
in the GENIE directory.

Use this command to open an existing strategy in a new window.    You can open multiple 
strategys at once.

You can create new strategys with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you 
select in the List Files of Type box. 

List Files of Type
Select the type of file you want to open:

Drives
Select the drive in which GENIE stores the file that you want to open. 

Directories
Select the directory in which GENIE stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Close command (File menu)

Use this command to close all windows containing the active strategy.    GENIE suggests that 
you save changes to your strategy before you close it.    If you close a strategy without 
saving, you lose all changes made since the last time you saved it.    Before closing an 
untitled strategy, GENIE displays the Save As dialog box and suggests that you name and 
save the strategy.

You can also close a strategy by using the Close icon on the strategy's window, as shown 
below:



Save command (File menu)

Use this command to save the active strategy to its current name and directory.    When you 
save a strategy for the first time, GENIE displays the Save As dialog box so you can name 
your strategy.    If you want to change the name and directory of an existing strategy before 
you save it, choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active strategy.    GENIE displays the Save As dialog
box so you can name your strategy.    

To save a strategy with its existing name and directory, use the Save command.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to 
save:
File Name

Type a new filename to save a strategy with a different name.    A filename can contain 
up to eight characters and an extension of up to three characters.    GENIE adds the 
extension you specify in the Save File As Type box.

Drives
Select the drive in which you want to store the strategy.

Directories
Select the directory in which you want to store the strategy.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four 
strategys you closed.    Choose the number that corresponds with the strategy you want to 
open.



Exit command (File menu)

Use this command to end your GENIE session.    You can also use the Close command on the 
application Control menu.    GENIE prompts you to save strategys with unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Attach Bitmap (File menu)

Use this command to attach a bitmap file to be used as a background to your displays.



Detach Bitmap (File menu)

Use this command to Detach a bitmap from the current displays background.



Undo/Can't Undo command (Edit menu)

Use this command to reverse the last editing action, if possible.      The name of the 
command changes, depending on what the last action was.    The Undo command changes to
Can't Undo on the menu if you cannot reverse your last action.

Shortcuts

Toolbar:
Keys: CTRL+Z or

ALT-BACKSPACE



Redo command (Edit menu)

<< Write application-specific help here. >>



Cut command (Edit menu)

Use this command to remove the currently selected data from the strategy and put it on the 
clipboard.    This command is unavailable if there is no data currently selected.

Cutting data to the clipboard replaces the contents previously stored there.

To Cut items in GENIE, select items that you wish to cut (see above, to Select Items).Then 
point your mouse to the cut command and press the left mouse button. This will cut and 
copy the selected items into a buffer. The items may now be "Pasted" to another location. 
Press "Paste" in the Edit menu. The selected items are now copied to the upper left of the 
screen area,    with new tag names. The group of blocks can now be moved to the desired 
location, using the instructions for Move (above). Remember that tag names must always 
be unique for like-blocks. This is the way that GENIE Runtime distinguishes one block from 
another.

Shortcuts

Toolbar:
Keys: CTRL+X



Copy command (Edit menu)

Use this command to copy selected data onto the clipboard.    This command is unavailable if
there is no data currently selected.

Copying data to the clipboard replaces the contents previously stored there.

To Copy items in GENIE, select items that you wish to copy (see above, To Select Items).Then
point your mouse to the copy command and press the left mouse button. This will copy the 
selected items into a buffer. The items may now be "Pasted" to another location. Press 
"Paste" in the Edit menu. The selected items are now copied to the upper left of the screen 
area,    with new tag names. The group of blocks can now be moved to the desired location, 
using the instructions for Move (above). Remember that tag names must always be unique 
for like-blocks. This is the way that GENIE Runtime distinguishes one block from another.

You can also copy blocks from one strategy to another, by following the above procedure for 
copying.    However, before pasting into another strategy, you must close the initial strategy 
first.    You can then start a new strategy and paste the blocks into it, or paste the blocks into
an existing strategy.    Remember that the blocks that you paste retain their prior 
configuration!

Shortcuts

Toolbar:
Keys: CTRL+C



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point.    This 
command is unavailable if the clipboard is empty.

Once items are selected (see above, To Select Items), they may be copied to another 
location by first pressing Copy, and then pressing the Paste command. The items will now be
pasted to the upper left of the screen.

Shortcuts

Toolbar:
Keys: CTRL+V



Select All
To select every item in the current Strategy, press this command.



Task
This command allows you to assign your strategy to a particular "Task". A task, or scan task, 
assigns the strategy a sample rate at which it will scan its associated blocks. There is 
actually a hidden block, the Task block, and this block has output to all of the blocks in the 
strategy that don't have an input.    The blocks without input are the starting points for each 
scan, which will begin at time intervals (sample periods) specified in the Scan Task Setup 
dialog box. The sample period is inversely proportional to the sample rate    You assign each 
scan task its own sample period, down to milliseconds resolution in the Scan Task Setup 
dialog box.

SCAN TASK DIALOG BOX
When assigning the sample rate to    a strategy, a scan rate may be assigned to selected 
blocks by using the Setup menu and the command "Tasks". When the Tasks command is 
executed, you enter    the Scan Task Setup dialog box. 

From this dialog box, you can supply a description for the pre-assigned tag name. You can 
also set the Scan period (the time interval between two samples) in hours, minutes, 
seconds, and milliseconds. It should be noted that the scan period should be set to the 
longest time that your strategy will allow, thereby reducing the processor overhead of the 
program.    

The Duration of the assigned task can also be set, based on whether you want the Scan Task
to run forever (Free Run), run for a limited time (Time Based), or to run for a limited amount 
of samples (Sample Based). Once all items have been selected, you can Close the menu 
(OK), Cancel, or choose Help by selection of the appropriate buttons.



Devices
The Devices command allows you to enter the Device Installation utility from the Strategy 
Editor menu bar. 

The utility allows you to setup I/O device instances. For information on the use of this utility, 
see    Manual Chapter 3.2.2, Installing Each Device Instance.



Runtime Preference

The Runtime Preference command allows you to configure GENIE with respect to how many 
errors that will be allowed before Runtime will stop because of excessive errors.    A Runtime
error is an error which occurs usually as a result of improper settings within GENIE, or 
because of hardware problems.    A list of Runtime errors is included in this manual in the 
Appendix.    Acceptable values for "No. of errors allowed before stopping" is between 0 
and 32767. 

Error Log
Runtime errors may be logged to the file RUNERR.LOG by checking the appropriate box Log 
errors to the error file RUNERR.LOG

The PCs speaker can be set to Beep when error occurs during the run if the appropriate 
box is checked.

Event Log
By checking Enable Event Log the event log files GENIE.ELF (first 100 events) and 
GENIE.ELH (remaining events) will be written to whenever    a loggable event occurs.    Such 
events consist of:

1)    The start and stop time/date of the strategy
2)    If in secure mode (password has been enabled by checking Enable Password 
Checking), password user ID/time of day will be logged when user logs in or out.
3)    Alarming information and acknowledgement if Alarm Log Block has been connected.

An example event log file GENIE.ELF follows:

User ABC logon at 13:33:32 04/13/1995
Strategy TASK1.GNI started at 13:33:32 04/13/1995
Strategy TASK1.GNI stopped at 13:34:01 04/13/1995
User ABC logoff at 13:34:01 04/13/1995
User ABC logon at 13:42:47 04/13/1995
Strategy TASK1.GNI started at 13:42:47 04/13/1995
ALOG1 HI 13:42:49
ALOG1 HI-HI 13:42:53
ALOG1 HI 13:43:02
ALOG1 LO 13:43:09
ALOG1 HI acknowledged 13:43:11
ALOG1 LO-LO 13:43:13
ALOG1 LO 13:43:22
ALOG1 HI 13:43:29
ALOG1 HI-HI 13:43:33
Strategy TASK1.GNI stopped at 13:43:34 04/13/1995
User ABC logoff at 13:43:34 04/13/1995

Event Log Viewer/Alarm Acknowledgement Dialog Box

While the strategy is running, alarms may be acknowledged by double-clicking on the Alarm Log Event 
(ALOG1 HI, etc. below). Alarms will be in the color red until acknowledged. For the Event Log dialog box 
to appear during Runtime, you must enable it via the View Menu. 



Change Password
Enter a password for the Lock feature in Runtime.    The password can consist of as little as 
no characters or spaces, for which simply the ESC key will unlock the strategy.    The 
password can, however, contain up to 16 characters or spaces, with no constraints on 
format.



Administration

The administrator may add and delete users with the use of this dialog box for the Lock feature in 
Runtime.    To Add and delete users:

1)    Enter the Supervisor Password previously entered using the Setup/Change Password dialog box.    
When GENIE is started for the first time, the Supervisor Password is blank. Once a Supervisor Password 
is Entered by using the Setup/Change Password dialog Box, that Supervisor Password stays in effect 
unless changed.    

Note:    If the Supervisor Password has been inadvertently forgotten,    you may start fresh by deleting the 
SECURITY.PW file located in the GENIE directory.

2)    Enter each User ID and corresponding Password by pressing Add User.    The user ID and password 
can consist of as little as no characters or spaces, for which simply the ESC key will unlock the strategy.    
The user ID and password can, however, contain up to 16 characters or spaces, with no constraints on 
format.



Run Menu

The Run menu is actually a command that allows you to access GENIE Runtime    directly 
from the Strategy Editor menu bar. Use this command to test a previously stored strategy by
pressing RUN with your mouse. 



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in GENIE, such as File Open.    A check mark appears next to the 
menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The 
toolbar provides quick mouse access to many tools used in GENIE,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Open a new strategy.

Open an existing strategy.    GENIE displays the Open dialog box, in which you can 
locate and open the desired file.

Save the active strategy or template with its current name.    If you have not named 
the strategy, GENIE displays the Save As dialog box.

Print the active strategy.

Remove selected data from the strategy and stores it on the clipboard.

Copy the selection to the clipboard.

Insert the contents of the clipboard at the insertion point.

Reverse the last editing.    Note:    You cannot undo some actions.

Go to the first record in the current selection.

Go to the previous record in the current selection.

Go to the next record in the current selection.

Go to the last record in the current selection.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and keyboard latch state. 
A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the GENIE window.    To display or hide the status
bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.    This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them.    If after viewing the description
of the toolbar button command you wish not to execute the command, then release the 
mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.



Labels
To display block labels that you define.    If you choose not to show labels, your display will be
somewhat less understandable, however, you may be able to see the connection wires more
clearly.



Zoom to Fit
To examine your strategy from afar, this command is used.    Used for overall placement of 
blocks.



New command (Window menu)

Use this command to open a new window with the same contents as the active window.    You
can open multiple strategy windows to display different parts or views of a strategy at the 
same time.    If you change the contents in one window, all other windows containing the 
same strategy reflect those changes.    When you open a new window, it becomes the active 
window and is displayed on top of all other open windows.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Tile Horizontal command (Window menu)

Use this command to vertically arrange multiple opened windows in a non-overlapped 
fashion.



Tile Vertical command (Window menu)

Use this command to arrange multiple opened windows side by side.



Window Arrange Icons Command

Use this command to arrange the icons for minimized windows at the bottom of the main 
window.    If there is an open strategy window at the bottom of the main window, then some 
or all of the icons may not be visible because they will be underneath this strategy window.



1, 2, ... command (Window menu)

GENIE displays a list of currently open strategy windows at the bottom of the Window menu. 
A check mark appears in front of the strategy name of the active window.    Choose a 
strategy from this list to make its window active.    



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can
jump to step-by-step instructions for using GENIE and various types of reference information.

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of 
GENIE.



Context Help command 

Use the Context Help command to obtain help on some portion of GENIE.    When you choose
the Toolbar's Context Help button, the mouse pointer will change to an arrow and question 
mark.    Then click somewhere in the GENIE window, such as another Toolbar button.    The 
Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application 
and strategy.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:
Application Control-menu button
Strategy Control-menu button
Maximize button
Minimize button
Name of the application
Name of the strategy
Restore button



Scroll bars

Displayed at the right and bottom edges of the strategy window.    The scroll boxes inside the
scroll bars indicate your vertical and horizontal location in the strategy.    You can use the 
mouse to scroll to other parts of the strategy.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the GENIE window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a strategy window.



Next Window command (strategy Control menu)

Use this command to switch to the next open strategy window.    GENIE determines which 
window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (strategy Control menu)

Use this command to switch to the previous open strategy window.    GENIE determines 
which window is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single strategy, the Close command on the 
strategy Control menu closes only one window at a time.    You can close all windows at once 
with the Close command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a strategy window

ALT+F4 closes the GENIE window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Ruler command (View menu)

<< Write application-specific help here. >>



Choose Font dialog box

<< Write application-specific help here. >>



Choose Color dialog box

<< Write application-specific help here. >>



Find command (Edit menu)

<< Write application-specific help here. >>



Find dialog box

<< Write application-specific help here. >>



Replace command (Edit menu)

<< Write application-specific help here. >>



Replace dialog box

<< Write application-specific help here. >>



Repeat command (Edit menu)

Use this command to repeat the last editing command carried out.    The Repeat menu item 
changes to Can't Repeat if you cannot repeat your last action.

Shortcut
Key: F4



Clear command (Edit menu)

<< Write application-specific help here. >>



Clear All command (Edit menu)

<< Write application-specific help here. >>



Next Pane

<< Write application-specific help here. >>



Prev Pane

<< Write application-specific help here. >>



Strategy. Editor Help

The Strategy Editor

The GENIE Strategy Editor is an icon based designing environment that provides, through 
the use of a Toolbox, the building Blocks that allow your control process to be designed, 
arranged, and viewed. Using only your mouse and keyboard, Blocks are connected together 
and used to communicate with your I/O hardware through a comprehensive Advantech DLL
driver to ultimately control and monitor your process. Display Items are connected to the 
strategy in order to display process events and allow supervisory control during GENIE 
Runtime. 

Entering the Strategy Editor

When you enter GENIE by double-clicking on the GENIE Strategy Editor Icon located in the 
Advantech GENIE Window, you are entering the Strategy Editor. You will see a window/screen
containing an empty work area and a Toolbox. 

The Toolbox contains icon blocks that you can grab with the mouse and place on the 
screen. These icon blocks provide the foundation with which you will construct your process 
strategy. The icons are then connected in an appropriate manner to the Display blocks that 
allow you to enter the Display Editor screen. All installed I/O devices are software-connected 
and configured through a dialog box associated with each I/O-type icon block -- AI (analog 
input), AO (analog output), DI (digital input), DO (digital output), and a Temperature block 
that provides you with a    thermocouple linearization function. The I/O devices receive 
outside process information and link with GENIE control and/or data acquisition logic. During 
GENIE runtime, the logical connections made between icon blocks and your I/O hardware 
allow real-time manipulation of controller outputs based upon inputs from the process.

Clicking first on one of the icons in the toolbox, then moving your mouse to the workpad 
(where the mouse pointer changes from a pointer to a cross-hair) and clicking again will 
place the icon on the workpad where it can be configured and connected to other icon 
blocks.    

Strategy Editor Blocks

Analog Input
Analog Output
Alarm Log
Digital Input
Digital Output
Display
Event Counter
Fast Analog Input
File, Input
File, Log
Hardware Event/Frequency Counter
Hardware Alarm
Moving Average
Network In
Network Out
On/Off Control
PID Control



Ramp
RS-232
Single Operator Calculation (SOC)
Speaker
Temperature Measurement
Timer
Time Stamp
Triggering
User Program 
Wavefile Playback

Creating Strategies

The typical procedure for developing a process/acquisition strategy consists of:

1)    Select and arrange the necessary icon blocks from the Strategy Editor Toolbox with your 
mouse.

2)    Connect the Blocks with the roll of wire provided in the Toolbox, into your desired 
control/acquisition strategy.

3)    Double-click on each icon block on the screen in order to configure the block's 
parameters.

4)    Enter the Display Editor to set up each Display Item.

A more detailed look at Strategy Building is provided in Chapter 3: Working With Genie.

GENIE (*.gni) Files

After the strategy is created, you save the strategy into a file with the suffix "gni". This is the
file type that the GENIE runtime system recognizes. After you save your strategy, you can 
modify it later by opening the file when in the Strategy Editor. You can also run this file from 
within the GENIE Runtime, or from the DOS command line. The *.gni files are stored in the 
C:\GENIE\STRATEGY directory by default.

Compatibility with GENIE 1.1 (*.gni) Files

All (*.gni) files created by a previous version of GENIE have to be loaded by the GENIE 
Strategy Editor and then saved before they can be run.    Some incompatibility might occur 
due to the file format change.    You can still use the old files in this case by deleting 
connections and reconnecting them.



Display Editor Help
The Display Editor is used to create the Operator Display Panel for the process, allowing a
dynamic interface with the running strategy. You can create a panel that is similar to test 
equipment or industrial process displays. You can also attach a bitmap background to 
customize your display. Dynamically linked software Display Items consist of Bar Graphs, XY 
Graphs, Strip Chart Recorders, LED Indicators, Numeric Displays, and Buttons. From these 
you create your operator Display/Control Panel.      

Display Editor Items

Anameter Displays
Bar Displays
Button Displays
Conditional Bitmap Displays
Conditional Button Displays
Conditional Text Displays
Historical Trending Displays
Knob Control Displays
Numeric Displays
Numeric Control Displays
Indicator Displays
Slider Control Displays
Text String Displays
Trend Graph Displays
YT Graph Displays
XY Graph Displays
Hi-Speed Trending Displays

Creating Displays

Double-clicking on a Display Block when in the Strategy Editor will invoke the Display Editor. 
The typical procedure for developing operator display panels from within the GENIE Display 
Editor consists of:

1)    Use the Toolbox to get desired Display Items with your mouse and place them on the 
screen at the desired locations.

2)    Change the size of the Display Item by pointing to one of the black squares on the 
Display Item's edge with your mouse. While holding down the left mouse key, drag the edge 
until the desired size is attained.

3)    Configure each Display Item by double-clicking anywhere on its surface. A dialog box will
appear where you can choose which Strategy Editor block's data to dynamically display (or 
control, if supported).

4)    Add Group Boxes and Text to the display panel to relate static display information.

5)    Save the Display.

For more in-depth information on Blocks, Display Items, and Runtime, see Chapters 2 and 3.



GENIE (*.gni) Files

After the strategy is created, you save the strategy into a file with the suffix "gni". This is the
file type that the GENIE runtime system recognizes. After you save your strategy, you can 
modify it later by opening the file when in the Strategy Editor. You can also run this file from 
within the GENIE Runtime, or from the DOS command line. The *.gni files are stored in the 
C:\GENIE\STRATEGY directory by default.

Compatibility with GENIE 1.1 (*.gni) Files

All (*.gni) files created by a previous version of GENIE have to be loaded by the GENIE 
Strategy Editor and then saved before they can be run.    Some incompatibility might occur 
due to the file format change.    You can still use the old files in this case by deleting 
connections and reconnecting them.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.





Print command (File menu)

Use this command to print a document.      This command presents a Print dialog box, where 
you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Selectio
n

Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.
Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog

The Printing dialog box is shown during the time that <<YourApp>> is sending output to the
printer.    The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed.    When 
you choose this command, the main window will be replaced with a print preview window in 
which one or two pages will be displayed in their printed format.    The print preview toolbar 
offers you options to view either one or two pages at a time; move back and forth through 
the document; zoom in and out of pages; and initiate a print job.



Print Preview toolbar

The print preview toolbar offers you the following options:
Print

Bring up the print dialog box, to start a print job.
Next Page

Preview the next printed page.
Prev Page

Preview the previous printed page.
One Page / Two Page

Preview one or two printed pages at a time.
Zoom In

Take a closer look at the printed page.
Zoom Out

Take a larger look at the printed page.
Close

Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup command (File menu)

<< Write application-specific help here. >>





Glossary

Actuator
A/D Converter
D/A Converter
Add
Analog
C , Celsius, Centigrade
CJC, Cold Junction Compensation
Comp Loop
Configure
Controller, Temperature
Conversion Rate
Counts
Deadband (Hysteresis)
Differential Input
F, Fahrenheit
Hold
Hz
Impedance
I/O Device
Input Resistance
Install
Instance
K, Kelvin
Measuring Junction
Multiplex
Overshoot
Range
Reference Junction
Remove
Resolution
Response Time
RTD
Secondary Junction
Settling Time
Setup
Signal Conditioner
Single Ended Input
Temperature Limit
Temperature Span
Temperature Stability/Instability
Thermocouple
Thermocouple Break Protection
Transducer
Wheatstone Bridge



Connection Wire

The connection wire is located in the upper right of the Toolbox. This wire is used to connect icon blocks, 
and    when this tool is clicked upon with the mouse, the cursor changes shape from a standard pointer to 
a shape that resembles a roll of wire. This roll of wire is used to logically    connect icon blocks together by
pointing the end of the wire roll to an icon containing output capability, clicking the left mouse button, 
moving the wire roll to an icon containing input capability, and clicking again. Wires will thus be auto-
routed. However, routing of wires can be performed manually by clicking the mouse on the screen surface
at desired right-angle wire-bend locations during connection. 

Depending on which block you click on first, the flow of data through the connection wire will be different.   
For example, if you wish to send data from an Analog Input block to the Display, you would click first on 
the AI block, then connect it to the display.    You will notice that the end of the connection wire that is 
touching the display block has an arrow that points into the display block.    This is correct, and denotes 
data flowing into the display block from the AI block. 

Some blocks will only allow data to flow one way.    Notice that if    you try to connect a wire between the 
display block and the data file block, you will get a message from GENIE saying that the data file block 
cannot accept an input.    The data file block is one that will only output data, and will never accept data.    
The direction of the arrow at the end of the connection wire denotes the flow of data from one 
block to another.



Time Stamp Block

This block has output capability. The current time may be assigned to the display or to a log file by 
connecting this block's output to a log file or Numeric/string display item.    
Different output formats are allowed, and these outputs are in the form of a string.



Analog Input Block (AI)

This block has output capability that supplies other blocks with analog input information from the I/O 
device's analog input section. When this block is double-clicked upon, all I/O devices currently installed 
that have available analog inputs are displayed in an associated dialog box. When a device is selected,    
all analog input channels for the device are displayed below it. You choose the hardware's analog input 
channel to be connected to a a particular AI block by clicking on the desired device's channel. Choose 
also the desired input range (gain) and Expansion Channel (mux channel), if applicable. 

The Scaling feature allows for block output scaling. Enter the hardwares configured Analog Input range, 
and then the desired range for the blocks output. As an example, a hardware device is configured to 
measure a range of 4 mA to 20 mA.    This range is actually used to provide tank levels from 0 to 50 ft 
deep. So, we enter the configured range as 4 - 20, and the desired range is entered as    0 - 50.    

The Update rate is a divisor which allows the Analog Input block to have a different effective scan rate 
than the rest of the strategy.    This is useful if, for example, your strategy is running at 100Hz, but you only
want to sample at a rate of 20Hz.    For this example, you would set the Update Rate to 5 (100 divided by 
5 (the update rate) gives an effective scan rate of 20Hz).    In this scenario, you will still get 100Hz data if 
you send the output to a Log File block or a display block, but only one in five samples will be "real".    The
other samples are merely copies of the "real" sample.    

Valid values for the update rate are between 1 and 32767.    

The Analog Input block also has DDE capabilities which allow it to exchange data with other Windows 
applications. The current strategy must be given a name (anyname.gni) for the Establish DDE link 
checkbox to be enabled. The checkbox will be disabled if the strategy filename is untitled. The current 
strategy filename is used as the topic name for your GENIE DDE link. To name or re-name the current 
strategy, go to the File menu and press Save or Save As. For more information about DDE, see "DDE 
Blocks (Client and Server)" later in this section.

Note: A separate Analog Input block is needed for each individual analog input channel.    For example, if 
you wish to use 7 channels of analog input, 7 separate and discrete analog input blocks would need to be
configured.



Fast Analog Input Block (FAI)

This block has input and output capability that supplies other blocks with fast analog input 
(DMA or Interrupt transfers) information from the I/O device's analog input section. When 
this block is double-clicked upon, all I/O devices currently installed that have available fast 
analog inputs are displayed in an associated dialog box. When a device is selected,    all fast 
analog input channels for the device are displayed below it..

High speed analog input blocks (FAI) may be controlled by the use of a digital line connected
to the FAI block input.    A digital one (1) starts hi-speed operations from the I/O hardware,    
and a digital zero (0) stops high speed operations. The digital start/stop to the FAI block 
input may be implemented with the Button Display Item or by any other digital icon block.

DIALOG BOX (Basic)

Scan Channels
Specify the hardware's analog input channel range to be connected to a a particular FAI 
block.    

Input Range(s)
Specify the input range(s), based upon whether the input range is to be performed over all 
I/O channels (Uniform), or if each channel should specify its own range (Varied).

Sampling Rate
Specify the desired sampling rate in Hertz for high speed operations.    When you specify the 
sampling rate for high speed operations,    this means that you will acquire data from the I/O 
device at a different rate than the scan period you specify in the Setup/Task menu dialog 
box. You will acquire an entire block of data at this sampling rate up to a specified Number 
of Points. The scan period determines    how fast the data may be examined by the 
strategy. The scanning process need to be fast enough to examine the data before it gets 
overwritten because the buffer is filled in a circular fashion.

Number Of Points
Specify how many samples are to be acquired for each block of data. This number is also 
used as memory buffer size that will be allocated at run-time. There is a very important 
relationship between Scan Period of the scan task, Sampling Rate, and Number of Points. 
Care need to be taken in order for them to work smoothly. 

If the Repeat Mode is One Shot, there is no possibility of data overrun    as long as Number Of
Point is equal to or larger than Sampling Rate. If the Repeat Mode is Continuous, the scan 
period of the scan task should be set at a period sufficiently shorter than the time for 
acquiring entire block of data (Number Of Points) so that the strategy can examine the data 
before it is overwritten by subsequent data. This means (Number of Points / Sampling Rate) 
> (Scan Period in second).    The rule of thumb is:

    (Number of Points) = (Sampling Rate) x (Scan Period in sec) x 1.25

Example: If you want to aquire data at the rate of    1000 sample per second and the scan 
period is 1 second, then Number of Point should be at least 1000 x 1 x 1.25 = 1250. The 
coefficient is depend on the machines performance. On a faster machine it can be closer to 
1.1. On a slower machine it should be increased to 1.4 or 1.5 if data overrun occurs.



Repeat Mode
Specify whether each block of data is to be continuously acquired (Continuous) or if only one
block of data is to be acquired (One Shot).

DIALOG BOX (Conditional Triggering)

Some I/O devices provide a method for comparing the incoming data to certain trigger levels
and conditions.    The Conditional AI dialog box provides parameters for such devices.

Acquisition Mode
1) Free Run -- acquires data normally.
2) Pre-Trigger -- acquires data until the condition of the comparator is matched.
3) Post Trigger -- starts to acquire data when the condition of the comparator is matched.
4) Position Trigger -- Acquires data that occurs before the condition of the comparator is 
matched (pre-data) and the data that occurs after (post data).

Trigger Condition(s)
Specify the trigger condition and channels.    If you want all channels (from start to stop 
channel) to trigger on the same condition, click on Uniform and specify the Uniform 
Condition.    If you want each channel to trigger on a different condition, click on Varied and 
select the Channel and Condition for each.

Trigger Level(s)
Specify the trigger level and channels.    If you want all channels (from start to stop channel) 
to trigger on the same level, click on Uniform and specify the Uniform High and Low Level. If 
you want each channel to trigger on a different level, click on Varied and select the Channel 
and High and Low Level for each.

SELECTION DIALOG BOX

This dialog box will appear when a connection attempt is made. For channel selection for 
each output connection with other blocks.



Digital Input Block (DI)

This block has output capability that supplies other blocks with digital input information from the I/O 
device's digital input section. When this block is double-clicked upon, all I/O devices currently installed 
that have available digital inputs are displayed in an associated dialog box. For each I/O device displayed,
all available digital input channels for the device are also displayed. You choose the hardware's digital 
input channel (bit) or channels (up to one byte of packed I/O) to be connected to a particular DI block by 
clicking on the desired device's channel(s) or bit(s).

The Update rate is a divisor which allows the Digital Input block to have a different effective scan rate 
than the rest of the strategy.    This is useful if, for example, your strategy is running at 100Hz, but you only
want to sample at a rate of 20Hz.    For this example, you would set the Update Rate to 5 (100 divided by 
5 (the update rate) gives an effective scan rate of 20Hz).    

The Digital Input block also has DDE capabilities which allow it to exchange data with other Windows 
applications. The current strategy must be given a name (anyname.gni) for the Establish DDE link 
checkbox to be enabled. The checkbox will be disabled if the strategy filename is untitled. The current 
strategy filename is used as the topic name for your GENIE DDE link. To name or re-name the current 
strategy, go to the File menu and press Save or Save As.
For more information about DDE, see "DDE Blocks (Client and Server)" later in this section.



Analog Output Block (AO)

This block has input capability that accepts another block's analog data and sends the data to the 
selected I/O device's analog output section. When this block is double-clicked upon, all I/O devices 
currently installed that have available analog outputs are displayed in a dialog box. For each I/O device 
displayed, all available analog output channels for the device are also displayed. You choose the 
hardware's analog output channel to be connected to a particular AO block (one AO block per I/O device 
AO channel) by clicking on the desired device's channel.    an example of an acceptable input would be 
from the User Program Block.    Again, you must use one analog output block per channel of desired 
analog output.

The Update rate is a divisor which allows the Analog Output block to have a different effective scan rate 
than the rest of the strategy.    This is useful if, for example, your strategy is running at 100Hz, but you only
want to output data at a rate of 20Hz.    For this example, you would set the Update Rate to 5 (100 divided
by 5 (the update rate) gives an effective scan rate of 20Hz).    

The Analog Output block also has DDE capabilities which allow it to exchange data with other Windows 
applications. The current strategy must be given a name (anyname.gni) for the Establish DDE link 
checkbox to be enabled. The checkbox will be disabled if the strategy filename is untitled. The current 
strategy filename is used as the topic name for your GENIE DDE link. To name or re-name the current 
strategy, go to the File menu and press Save or Save As.
For more information about DDE, see "DDE Blocks (Client and Server)" later in this section.



Digital Output Block (DO)

This block has input capability that accepts another block's digital data and sends the data to the selected
I/O device's digital output section. When this block is double-clicked upon, all I/O devices currently 
installed that have available digital outputs are displayed in an associated dialog box. For each I/O device
displayed, all available digital output channels (bits) for the device are also displayed. You choose the 
hardware's digital output channel(s) to be connected to this DO block by clicking on the desired device's 
channel(s) or bit(s).    

The Update rate is a divisor which allows the Digital Output block to have a different effective scan rate 
than the rest of the strategy.    This is useful if, for example, your strategy is running at 100Hz, but you only
want to output data at a rate of 20Hz.    For this example, you would set the Update Rate to 5 (100 divided
by 5 (the update rate) gives an effective scan rate of 20Hz).    

The Digital Output block also has DDE capabilities which allow it to exchange data with other Windows 
applications. The current strategy must be given a name (anyname.gni) for the Establish DDE link 
checkbox to be enabled. The checkbox will be disabled if the strategy filename is untitled. The current 
strategy filename is used as the topic name for your GENIE DDE link. To name or re-name the current 
strategy, go to the File menu and press Save or Save As.
For more information about DDE, see "DDE Blocks (Client and Server)" later in this section.



PID Control Block

This block allows for input and output. The input consists of a measured value (feedback) to be controlled 
to the setpoint value (either dynamic or static). The block's output is the controller output.

Theory:
A controller is capable of receiving a signal from a sensor (usually temperature) within a process and 
regulating an input to that process in order to maintain a selected value or set point/control point. 

The PID controller is the most widely used type of process controller. It is the ability to tune its control 
action to specific time constants and therefore to deal with process changes over time that has earned the
PID controller its wide acceptance. To perform the control, what is desired is to measure the difference 
(error) between the desired value (setpoint) and the measured value (feedback), and reduce that error. 
The PID controller is the most efficient type of process controller. 

The control functions of the PID controller may be separated into three types, which can be used based 
upon application requirements. The three functions are: One, two, and three mode control.

One Mode Control (Proportional)
Simplest type of proportional control whereby the controlled process input is regulated to a value 
proportional to the difference between the control setpoint and the measured value. Controls the 
proportional band. The larger the value of the proportional constant, the harder the system will react to 
differences between the setpoint and the actual measured value. A simple proportional controller may be 
achieved by setting the reset rate (I) and derivative times (D) to zero.

Two Mode Control (Proportional/Integral)
Introduces an additional reset control action which depends upon the accumulated error x time product 
(integral). The sum of the error and reset signals continuously act to make the actual error signal smaller 
-- stopping when the measured value reaches the desired control setpoint. A    PI controller is achieved by 
setting the derivative (D) value to zero.    

Three Mode Control (Proportional/Integral/Derivative)
With an additional rate sensing (derivative) action which reduces tendency to overshoot a control setpoint 
by anticipating the approach of a zero value error signal and initiating a control response reversal before 
the measured value (usually sensed temperature) actually gets there. Proper use of the derivative term 
can result in much faster process response.

PID CONTROL DIALOG BOX

P -- PID proportional control constant

I    -- PID integral mode gain constant

D -- PID derivative mode gain constant

Low Clamp -- low clamping value for output. Prevents voltage swings from exceeding the range of the 
hardware used for the control (usually D/A converter).

High Clamp -- high clamping value for the output.

Setpoint -- The PID setpoint value, or desired value. Can be changed on the fly (dynamic) by specifying a 
ramp or other block    to be used as the dynamic setpoint.    If a constant setpoint is desired, enter the 
static setpoint.





On/Off Control Block

This block allows both input and output. The input consists of a measured value (feedback) to be 
controlled to within a certain tolerance (deadband), determined by a setpoint (either dynamic or static). 
The output is either digital low or high, depending on controller output. 

Theory:
Non-proportional control in which the controlled process input is either fully ON or fully OFF depending on
whether the measured value (feedback) is above or below the control point (setpoint) deadband. 

ON/OFF CONTROL DIALOG BOX

Setpoint -- The On/Off setpoint value, or desired value. Can be changed on the fly (dynamic) by 
specifying a ramp or other block to be used as the dynamic setpoint. If a constant setpoint is desired, 
enter the static setpoint.

Delta Low    -- Low value for generation of the deadband. Lower section of deadband is equal to Setpoint 
- Delta Low.

Delta High -- High value for generation of the deadband. Upper section of the deadband is    equal to 
Setpoint + Delta High.

In addition, you have the option of outputting either a 0 or a 1 value for inputs over the high limit, which 
would make the output 1 or 0, respectively, for inputs under the low limit.    
    
If no deadband is desired, simply set the delta low and delta high values to zero. In this way, ALARM 
CONTROL can be achieved, when using a static setpoint.



Ramp Block

This block allows input and output. A ramp of floating point values may be generated by using this block. 
By connecting a high digital value to the reset input, the ramp can be reset to its starting value. By 
applying a high digital value to the hold input, the ramp may be temporarily held at the current value. The 
rate of increase/decrease of the ramp is proportional to the sample rate (scan task period) selected. 

RAMP BLOCK DIALOG BOX

Start Value -- A floating point value at which the ramp will start.

Stop Value -- A floating point value at which the ramp will finish. Can be above or below the Start value.

Increment/Decrement    -- Each step up/down the ramp will be equal to this value.

Reset Block -- The trigger block (any digital type block) used to apply a digital high/low to    reset/start the 
ramp. A digital high applied to this input resets the ramp and stops ramping. A digital low allows ramping 
to occur. No reset input is treated as a low input.

Hold Block -- The block used (any digital type block) to hold the ramp at the current value.    A high digital 
signal applied to this input stops ramping at the current value. A    low    applied to this input will 
enable/resume ramping. No hold input is treated    as a low input.



Event Counter Block

This block has both input and output capability. A software event counter that    counts digital rising edges 
(digital high events) from any block supplying digital information (1's and 0's). The block's output can be 
sent to another block, such as to the display block. Each count is performed with each scan; therefore 
counting speed is equal to the sample period of the system. By connecting a high digital value to the reset
input, the count can be reset to its starting value and counting is stopped. A low value to the reset input 
will enable counting (reset input    not connected is    treated as a low). By applying a high digital value to 
the hold input, the count may be temporarily held at the current value. A low on the hold input will resume 
counting (when hold input is not connected, this is treated as a low).

EVENT COUNTER BLOCK DIALOG BOX

Start Value -- An integer value at which the Counter will start. (maximum 65535)

Stop Value -- A integer value at which the Counter will finish. Can be above or below    the Start value. 
(maximum 65535)

Increment/Decrement    -- Each integer up/down count will be equal to this value.

Input Block -- The block from which you would like to count pulses (rising edges).

Reset Block -- The trigger block (any digital type block) used to apply a digital high/low to    reset/start the 
counter. A digital high applied to this input resets the counter    and stops counting. A digital low allows 
counting to occur. No reset input is treated as a low input; counting will free-run in this case.

Hold Block -- The block used (any digital type block) to hold the count at the current value. A high digital 
signal applied to this input stops counting at the current value. A low    applied to this input will 
enable/resume counting. No hold input is treated as a low input.



Temperature Measurement Block

Similar to the AI (analog input) block, this block allows for outputting data to another block directly from 
the I/O device. Transforms the analog input data from the I/O device into linearized temperature data in 
degrees C,F,K, or R. Thermocouple types supported are J, K, S, T, B, R, and E.

The Update rate is a divisor which allows the Temperature Measurement    block to have a different 
effective scan rate than the rest of the strategy.    This is useful if, for example, your strategy is running at 
100Hz, but you only want to output data at a rate of 20Hz.    For this example, you would set the Update 
Rate to 5 (100 divided by 5 (the update rate) gives an effective scan rate of 20Hz). In this scenario, you 
will still get 100Hz data if you send the output to a Log File block or a display block, but only one in five 
samples will be "real".    The other samples are merely copies of the "real" sample.    

The Temperature Measurement block also has DDE capabilities which allow it to exchange data with 
other Windows applications. The current strategy must be given a name (anyname.gni) for the Establish 
DDE link checkbox to be enabled. The checkbox will be disabled if the strategy filename is untitled. The 
current strategy filename is used as the topic name for your GENIE DDE link. To name or re-name the 
current strategy, go to the File menu and press Save or Save As.
For more information about DDE, see "DDE Blocks (Client and Server)" elsewhere in this section.

TEMPERATURE MEASUREMENT DIALOG BOX

Device -- Choose the device from the installed I/O device list.

Channel -- Choose the analog input device channel.

Input Range -- Choose the input range, if applicable.

Expansion Channel -- Choose the expansion (mux) card channel.

Temperature Scale -- The desired temperature scale in degrees C (Celsius),F (Fahrenheit) ,K (Kelvin) , 
or R (Rankine). 

Thermocouple Type -- Choose the type of thermocouple that the hardware supports.

Establish DDE Link -- Allows you to establish a link with other Windows applications.    See "DDE Blocks 
(Client and Server)" elsewhere in this section.

Update Rate -- Change the effective scan rate of this particular block.    The value entered is acts as a 
divisor; the scan rate divided by the update rate gives the effective scan rate for this block.



Display Block

This block has both input and output capability. You can connect any block to, or gather dynamic 
information from, one or many display panels by connecting to this block type. By double-clicking on the 
block, an associated display panel appears in the Display Editor. You can now create a custom 
operator/display panel by arranging various Display Items -- bar graphs, XY graphs, indicators, buttons, 
and numeric controls and displays, each logically connected to a chosen Strategy Editor icon block. Since
each Display Block is connected with its own display panel, multiple display panels may be created, each 
capable of displaying multiple display items and/or operator controls.

The Update rate is a divisor included in some display items which allows them to have a different 
effective scan rate than the rest of the strategy.    This is useful if, for example, your strategy is running at 
100Hz, but you only want to display data at a rate of 20Hz.    For this example, you would set the Update 
Rate to 5 (100 divided by 5 (the update rate) gives an effective scan rate of 20Hz).    For this example, 
only one in five samples would be displayed; the others would be ignored.    

Also, keep in mind that many, many blocks can be connected to one display block.    Within that single 
display block, many different display items can share data from one particular block (displaying it in 
different formats) with only one single connection wire from the inputting block. 

You can return to the Strategy Editor from the Display Editor by clicking on Window on the Menu bar, and
selecting Strategy Editor.



User Programmable Block

This block allows for both input (up to 8 channels)    and output (up to 8 channels).    You can connect the 
inputs and perform math operations on those blocks. You can also write a program that acts on the 
inputted blocks as variables, with one or many lines in the program. Up to eight inputs and up to eight 
outputs are supported by the User Programmable Block.

This block is designed to provide total flexibility so you can do comparisons, calculations, conditional 
statements, branches and loops. It uses C-like syntax without the complexities of actual C programming. 
It is, however, only an interpreter, not a compiler, and so some speed is compromised in the name of 
simplicity.    The User Programmable block was designed for small amounts of code, not large, complex 
programs.    It supports multiple inputs from all types of blocks. Its output(s) can be routed to any number 
of blocks. You can write a program to manipulate inputs, calculate an output based on the inputs, or 
simply skip to the next scan (sample) without any output for the current scan. In the last case, all blocks 
that have this programmable block as an input will not be processed for the current scan. You can also 
halt the entire runtime session by use of this block.

USER PROGRAMMABLE BLOCK DIALOG BOX

The user programmable block dialog box consists of three sub-boxes: the input blocks box, the 
operators box , and the program editor box. The input blocks list box provides the list of all inputs 
currently connected to the user programmable block. The operators list box provides the list of all 
available operations (see list below). The program editor box is an editor where you can type-in program 
statements. Clicking on an input block in the input block list box inserts the tag name of that input block 
into the program editor box. Clicking on an operator has the same effect.

Program
A program consists of one or more statements that follow the correct syntax. 

Statements
Statements consist of keywords, expressions, and other statements. A statement that forms a component 
of another statement is called the "body" of the enclosing statement. Carriage-return and line-feed 
characters add no meaning to a program, so a statement can be in a single line or broken into several 
lines. The User Programmable Block recognizes the keywords if,    else,    while,    output,      skip,     and 
stop; any connected block's tagname variables (AI1, DO2, etc.); and the variables  a - z and a1 - z1 to a9
- z9.  Each of the following statement syntax types are valid:

1)    expression ;
2)    if    ( logical expression )    statement ;
3)    if    ( logical expression )    statement ;    else    statement ;
4)    while    ( logical expression  )    statement ;
5)    output  expression ;
6)    skip ;
7)    stop ;
8)    display  expression ;
9)    substr  expression ;
10)    sprintf  expression ;
11)    time  expression ;
12)    date  expression ;

The keyword output allows you to output an expression to the next block (connected to this block's 
output). When outputting data from the User Programmable Block,    the data output may be in the form of



an integer, floating point value (real number), or string.    Since the block can output eight different data 
values,    the syntax for the output keyword is output expression    where expression contains as the first 
parameter the output channel number (#0 - #7) and the second parameter contains a value to be sent.    If
outputting a string,    the string must be in quotes (String). If no channel number is provided,    the 
default channel 1 (one) is used.    Examples are as follows:

1)    output(#2, This String);    //    outputs a string to channel 2
2)    output Another String;      //    outputs a string to channel 1 (default channel number)
3)    output(#7, String + a4); //    outputs string + a4, where a4 = Another String to channel #7
4)    output(#1, AI1 + AI2);          //    outputs tagnames AI1 + AI2 to channel #1
5)    output(#7, 1);                                    //    outputs 1 to channel #7

When the output of this block is connected to the input of another block,    a dialog box will appear asking 
you to specify the output channel number desired (#0-#7).    If the program does not assign a value to a 
particular channel number specified at any given moment,    its output will be zero (0) until an output is 
valid.

The keyword skip allows you to skip (wait) to the next scan or sample before proceeding.

The keyword stop allows you to halt the runtime session immediately.

The keyword display allows you to change between different displays during runtime. The syntax for the 
display keyword is display expression    where expression contains as the parameter the display number 
(N). Example is as follows:

1)    display(2);    //    changes display to display number 2

The keyword substr allows you to parse a string into a sub-string during runtime. The syntax for the 
display keyword is substr expression    where expression contains as the 1st parameter the string or 
string variable to be parsed.    The 2nd parameter contains the character number at which to start parsing 
(the first character in the string is represented by a one (1)). The 3rd parameter contains the sub-string 
length, or how many characters to parse. Example is as follows:

d5 = This string;

1)    substr(abcdef, 5, 2);    //    starting at the 5th character, e, parse out 2 characters, ef
2)    substr(d5, 6, 6);    //    starting at the 6th character, s, parse out 6 characters, string

The keyword sprintf allows you to format and store a series of characters and values in a buffer variable. 
The syntax for the sprintf keyword is sprintf expression    where expression contains as the 1st parameter
the string or string variable to act as a buffer for the formatted string to be stored.    The 2nd parameter 
contains the format type for the argument. The 3rd parameter contains the argument to be formatted. The
argument is converted and output to buffer according to the format specification in format. The format 
consists of ordinary characters and has the same form and functionality as the format argument in the 
ANSI C function printf(). However, only one argument can be formatted with this version of sprintf.    
Example is as follows:

// This program uses sprintf to format various
// data and place them in the string named b.

s = "computer";
c = l;
i = 35;
f = 1.7320534;
      // Format various data: 



sprintf( b,          "\tString:        %s\n", s );
sprintf( b, "\tInteger:      %3d\n", i );
sprintf( b, "\tReal:            %6.3f\n", f );

The keyword time allows you to return a time string with format HH:MM:SS during runtime. 
The syntax for the time keyword is time() where no expression is necessary. Example is as 
follows:

t5 = time();

The keyword date allows you to return a date string with format HH/MM/SS during runtime. 
The syntax for the date keyword is date() where no expression is necessary. Example is as 
follows:

d5 = date();

Statements
The word statement in italics represents a single statement or compound statement. A compound 
statement is one or more statements enclosed by a pair of curly brackets { }. Note that a compound 
statement doesn't need to be ended by a semi-colon character like a single statement does, so there is 
no semi-colon after the closing bracket. The brackets are just a way of grouping single statements.    

To include comments within the User Program block, use two forward slash marks (//) to begin each 
comment line.

Expressions
An expression is a sequence of operands (variables or numbers) and operators (math functions) that 
computes a value. The computed value can be a number or a logical true/false. The simplest expression 
is a constant (operand) without any operator.

Examples of valid expressions are:

    3
    AI1+AI2
    (abs(AI1)*2.5) + 1
    AI1 > 0 && AI2 < 0

The last example contains a logical expression. Some operators have higher precedence than others. An 
operator with higher precedence is always processed before the one with lower precedence. The 
following table (table 1) shows the precedence in descending order and associativity of the operators:

Table 1, Precedence and Associativity of Operators

Symbol Type of operation Associativity
(    ) Expression Left to right
-
!

Unary minus
Unary negation 

Right to left

*
/
%

Multiply
Divide
Remainder

Left to right

+    - Additive Left to right
<    >    <=    
>=

Relational Left to right

==    != Equal, Not equal Left to right



& Bitwise AND Left to right
| Bitwise OR Left to right
~ Bitwise NOT Right to left
^ Bitwise XOR Left to right
<<
>>

Shift Left
Shift Right

Left to right

&& Logical-AND Left to right
|| Logical-OR Left to right
= Assignment Right to left

Table 2: Mathematical Functions

Function Argument Returns...
abs() integer or 

float
Absolute value of argument

cos() Float or 
integer 
(radians)

Cosine of argument

int() Float Integer from Floating point 
argument

rnd() Integer 
seed value

Random number starting 
from argument (seed)

sin() Float or 
integer 
(radians)

Sine of argument

sqr() Float or 
integer

Square-root of argument

ln() Float or 
Integer

Natural Log of argument

log10() Float or 
Integer

Log of argument

exp() Float or 
Integer

e to the x argument

pow(x,y) Float or 
Integer

x argument to the y power

tan() Float or 
integer 
(radians)

Tangent of argument

The mathematical functions that are available in the User Programmable block are shown in Table 2: 
Mathematical Functions. 

The int() function deserves special attention here.    When an expression that involves a floating point 
value and an integer is evaluated in the user program block, the return value is then converted to a 
floating point value.    In some cases, you may want an integer value returned instead, and int() will do 
this.    Int() converts a floating point value to an integer value.    For example, if the floating point value is 
1.49, int() will return a value of 1.    If the floating point value is 1.51, int() will return 2.    Therefore, Int() will
return the rounded value of the floating point value, rounded to the nearest integer.

Variables
The variables (a - z and a1 - z1 through a9 - z9) can be used for any purpose, but it must be remembered
that if a variable is used in one user programmable block, its value will be seen by all other user 
programmable blocks that use the same variable. This effect may be desirable in some cases, but it is 
usually good practice to use different variables for each user program block. The displayed input block 
variables (tagnames AIN, DIN, etc.) can also be used as operands. 



For example:

if    ( AI1 > AI2 )
{
        a = AI1 * 0.117;    // this is how to 
        output    a; // use a comment
}

The above program checks if analog input 1 (AI1) is greater than analog input 2 (AI2). If it is, the variable 
'a' is used to hold the product of AI1 and the constant 0.117 (scaling factor). The product is then sent to 
the next block (output). All statements inside the curly brackets (compound statement) are done only if 
AI1 > AI2.

Note:
If the tagname is from a block that has multiple outputs and two output channels are displayed, such as:

PRG1:PRG1:[channel 1]
PRG1:PRG1:[channel 2]

notice that the tagname for both channels is the same (PRG1).    You can specify each channel separately
in your program by using the tagname as an array with the index as the channel number.    Example:

a = PRG1[1] + PRG1[2];        // variable a = PRG1 channel 1 + 2



Running/Moving Average Block

This block allows for input and output. One input is averaged over a number of samples defined by the 
user. For instance, if it is desired to average the present sample value with the previous 9 samples, then 
the user chooses 10 as the number of    samples to be averaged. This will tend to smooth out noise and 
any extraneous signals.    The Moving Average block should be placed between the sampling block and 
the next logical block, i.e. the display block, etc.



Triggering Block

This is a conditional triggering block, and has input and output capability. The triggering block can be 
thought of as a valve that controls when data will start and/or stop flowing from one block to another.    

Triggering Dialog Box

The following options are available within the triggering block dialog box:

Time-Based Delay:    Data is delayed a specified amount of time (in 0.1 second increments) before being
allowed to be input into another block.

Cyclic Time-Based Delay:    A sample is taken in a cyclical fashion.    If, for example, the delay time is 1 
minute, one sample would be taken at time=0 then another at time=1 minute, and so on.    

Sample-Based Delay:    Data will be allowed to pass only after a specified number of samples have been
taken.

Cyclic Sample-Based Delay:    Similar to Cyclic Time-Based Delay; however, instead of a specified 
amount of time, the delay is based on a specified number of samples.    For example, if the delay is set to 
10 samples, sample number 1 through 10 would be ignored, then sample number 11 would be passed.    
The process would then restart.

Input is ABOVE the Trigger Value (Level-based Triggering):    Output is allowed from the block as soon
as the input is higher than the specified Trigger Value level.    For instance, if the Trigger Value that you 
set is 3 Volts, and the input starts at 4 Volts, output is always allowed.    If, however, the input starts below 
3 Volts, output is not allowed until the level of the input rises above 3 Volts.    After triggering occurs, 
output is always allowed until reset (see Reset From option below).

Input is BELOW the Trigger Value (Level-based Triggering):    Same as Input is ABOVE the Trigger 
Value, except triggering occurs as soon as the input is below the Trigger Value level.

Input is RISING and PASSING the Trigger Value    (Rising Edge-Triggering):    Output is allowed from 
the block as soon as the input value rises from below, and through a specified Trigger Value level.    
Output will continue until the block is reset or until the Strategy ends.    For example, if the trigger level is 
set to 3 Volts when the Strategy begins, and the input waveform is at 4 Volts, no output will occur from the
block.    As soon as the waveform goes below the 3 Volt level, and then rises through the 3 Volt level, 
triggering occurs and output will be allowed from the block.    Output will continue until reset (see Reset 
From option below) or the end of the Strategy occurs. 

Input is FALLING and PASSING the Trigger Value (Falling Edge-Triggering):    Same as Input is 
RISING and PASSING the Trigger Value, except triggering occurs as soon as the input falls below the 
Trigger Value level.

Digital input is EQUAL to Trigger Value:    Output is allowed after the input value (digital) becomes 
exactly equal to an integer Trigger Value that you set in the dialog box.

The Start/Stop Method will start allowing samples to be output from the block if Start when trigger 
condition is true is selected.    Conversely, the block will stop allowing samples to be output if Stop 
when trigger condition is true is selected.    

The Reset From option allows a triggering reset when a non-zero value is input to the Triggering Block's 
reset input.





Data File Block

This block has output capability. By using this block, data can be retrieved from a file. The data will be 
retrieved one line at    a time with each system scan (sample). When the end of the data is reached, it will 
be re-scanned (loop back will occur). An ASCII file must be created containing the data formatted into one
column of values -- either integer or floating point. Specify the filename in the associated dialog box. 
Connect the block to the block to which the data will be sent.



Log File Block

This block has input capability (8 inputs maximum). The block allows data    from inputs to be logged to a 
file in multiple column format. Each block from which data is to be logged corresponds with one column in
the file. You can specify the storage type (format) for the file -- either in ASCII, binary float, byte, integer, 
or long integer. The update method can be either to append new data or to overwrite old data. You can 
include a header and comments at the beginning of your file if you desire. You can specify the width, in 
characters, of each column of data, along with decimal point placement. For each input to be logged, you 
can specify to which column number    the input block's data will be sent. When the file log block is 
double-clicked upon, all input block tag names are displayed with the default column number starting at 1 
(one). You can change the column numbers by double-clicking on each input tagname so that a dash (--) 
is displayed instead of the column number. Double clicking again on each input's tagname, starting at the 
one    you want to be logged as column 1 (one) in the file, will cause them to be numbered the way you 
want. By pressing the Options button, you can specify each column's width (how many characters),    
desired header information, and decimal point format. 

The Advanced button will allow you to set up a total of 16 possible combinations for opening and closing 
the file (4 options for opening and 4 options for closing).

 The four OPEN options are described as follows:
A. Open at the beginning of the run: The file is opened immediately when the run is started.
B. Open after N scans: GENIE waits until N scans have passed to open the file.
C. Open if "File Control" is 1: "File Control" is a control signal to the Log File Block from another block. 
The file is opened when this signal is 1. The file is closed when this signal is 0.
D. Open at N minutes from midnight: This option is good for doing a job that is repeated daily at the 
same starting time. This allows the file to be opened at N minutes from midnight for the first file-open. The
subsequent files are controlled by file-close options.

The four CLOSE options are described as follows:
A. Close at the end of the run: This is the same as the original file-close of version 1.0. The file is closed
immediately after the run is stopped.
B. Close after every N records: Starting from the moment the first file is opened, this option allows the 
file to be closed after every N records. The next file is opened right after the previous file is closed, if 
needed.
C. Close if "File Control" is 0: "File Control" is a control signal to the Log File Block from another block. 
The file is closed when the signal becomes 0. The next file is opened when the signal becomes 1 again.
D. Close after every N minutes: Starting from the moment the first file is opened, this option allows the 
file to be closed after every N minutes. The next file is opened right after the previous file is closed, if 
needed.

In order to generate a different filename each time a file is created, some of the OPEN/CLOSE options 
listed above require wildcard character(s) in the filename. The only wildcard character supported in 
version 1.01 is the # (pound sign). The "#" character can appear at any position in the standard DOS file 
name in the place of a regular character. It will be replaced by a digit (0-9) to    form a real file name. Use 
more "#" characters together if you need to have a large number of files. A wildcard such as 
"FILE###.LOG" can generate 1000 file names from "FILE000.LOG" to FILE999.LOG". Make sure there 
are enough digits there for your strategy. All wildcard characters must be together (contiguous).

    Valid filename examples using wildcards:

MYFILE##.LOG        MY###R.LOG        MYFILE.###      
MYFILE.L## ########.TXT #RECORD.TXT



    Invalid filename examples using wildcards:

MY#FILE#.LOG        # sign should be adjacent to each other
 FILE##.##T          # sign should be adjacent to each other
 MYFILE###.TXT    File name too long, should be in 8.3 format



Beep Block

This block accepts one input. For alarming to the speaker in the PC or external speaker. For 
use with a digital block as input. This block was called Speaker block in the previous version.



 Timer Block

Accepts inputs (for reset purposes) and also allows outputs. Time can be absolute, or elapsed, and 
resolution can be in ticks (0.1 seconds) or seconds. The time cycle range can be set from each minute to 
each year. Output (elapsed or absolute time) can be sent to another block.

The Timer Block's output is a long integer from 0 to 4294967295.    This block is very useful for any type of
control strategy that involves time as an element.

The units of the timer's output value is in either seconds or 1/10 seconds, depending upon the resolution 
that you choose. Because of the constraints of the Windows environment, it is difficult to get better 
resolution than what we have provided here.

The output of the timer block is cyclic if one of the cycle options is chosen.    For example, the output of 
the timer block with "Elapsed time" type, "Second" resolution and "Minutely" cycle goes from 0 to 59 and 
back to 0. The same block with hourly cycle will output 0 to 3599 and back to 0.

The timer block can be reset by another block; a value of 1 input to the timer block reset will reset the 
timer. 

For a timer block with Time-Of-Day (absolute) type, the output doesn't start from 0 at the beginning of the 
run. It gives the number of seconds or 1/10 seconds since the boundary of the cycle, according to the 
computer's clock.    For example, the output of an hourly timer (with seconds resolution) is 0 every hour on
the hour, then incremented to 1,2,3, .... ,3599, then back to 0 on the next hour. The boundary of various 
timer cycles are listed as follows:

YEARLY:      Starts from 0 at 00:00:00 AM January 1st every year.
MONTHLY:    Starts from 0 at 00:00:00 AM the first day of each month.
WEEKLY:      Starts from 0 at 00:00:00 AM on Sunday every week.
DAILY:        Starts from 0 at 00:00:00 AM every day.
HOURLY:      Starts from 0 every hour on the hour.
MINUTELY: Starts from 0 every minute on the minute.

It's easy to calculate the actual time based on the cycle type. For example, the weekly timer outputs 
86400 at 0:00 AM Monday morning and 518400 at 12:00PM Friday midnight. You can use this value as 
input to the User Program Block and use it to turn something off during the weekend or turn something on
during the weekdays. You can also use several timers with different cycles to do more complicated timer 
control.

See TIMER.GNI (in the GENIE\Strategy directory) as an example of how to use the Timer Block. This 
strategy makes 3 beeps at 0th, 2nd and 4th second of every minute for the first 5 minutes of every hour 
Monday through Friday.



 RS-232 Block

The RS-232 block (or Serial Interface block) is used for communication between the GENIE 
host computer and other serial devices (other computers, ADAM modules, etc.) that support 
the RS-232 standard. 

Data in the form of a prompt string can be sent out to the serial device, and the response 
can be fed to another block within GENIE.    If the prompt string is to be static (not to be 
changed) then the string is entered in the dialog box by the user.    As a dynamic alternative, 
the prompt string may be sent in the form of an input to the block by connecting a User 
Programmable or other block capable of string variable types.    

Double-clicking on this block will bring up the dialog box where you can configure the 
communication parameters that GENIE will use.    Standard conventions are used for the 
port, data bits, parity, and stop bits.    

Idle time is the time (in ms) that GENIE will wait before it starts looking for a response from 
the serial device.    This feature is very convenient since some serial devices are very slow to
respond.    Using an idle time will eliminate time-out errors when slow serial devices are 
used.

Wait time is the time (in ms) that GENIE will wait for a return string after the idle time has 
elapsed.    If the wait time passes with no string received, or no final character, then GENIE 
will retry (see below) sending the prompt string.    

Retry is the number of times that GENIE will retry sending the prompt string before 
terminating.    Acceptable numbers for retry are between 0 and 3.

Note: The sum    (Idle+Wait ) must be less than the scan task period.

The initial string (Init String) can be used to configure the serial device.    It will be sent out 
as a first string, and the data that is sent back to GENIE will be thrown away.    

After the initial string is sent, and the response (which is ignored) is received, the Prompt 
String will be sent, after which all data received back (Response String) can be used by 
another block that is connected to the RS-232 block. You must specify the starting and 
ending point with respect to the data in the string.    By pressing More, additional response 
strings may be parsed through the use of an Additional Response Strings dialog box 
(shown below).

The "Init String" and "Prompt String" fields allow the user to enter control characters in the 
range of ASCII 0 to ASCII 31.

For example, entering "This ^A^B^C^[ String^M" is converted to "This 
<Ctrl_A><Ctrl_B><Ctrl_C><ESC> String<CR>" where <Ctrl_A> is ASCII 1 and <ESC> is 
ASCII 27.

ASCII Enter Meaning
0 ^@ Null
1 ^A Start of Heading
2 ^B Start of Text



3 ^C End of Text
4 ^D End of Tape
5 ^E Enquiry
6 ^F Acknowledge
7 ^G Bell
8 ^H Backspace
9 ^I Horizontal Tab
10 ^J Line Feed
11 ^K Vertical Tab
12 ^L Form Feed
13 ^M Carriage Return
14 ^N Shift Out
15 ^O Shift In
16 ^P Data Link Escape
17 ^Q Device Control 1
18 ^R Device Control 2
19 ^S Device Control 3
20 ^T Device Control 4
21 ^U Negative Acknowledge
22 ^V Synchronize
23 ^W End of Transmitted Block
24 ^X Cancel
25 ^Y End of Medium
26 ^Z Substitute
27 ^[ Escape
28 ^\ File Separator
29 ^] Group Separator
30 ^^ Record Separator
31 ^_ Unit Separator

The string entered will be converted to a final string using the following scheme:

      1. The "^" character followed by a character from "@" to "_" is interpreted as the lower 
32 control characters in the ASCII table.    ^@ is NUL,    ^A is control-A, ^B is control-B, etc.    
(letters:'A' to 'Z' are upper case only)

      2. Backquote character "`", which is also called a grave accent, means the next character
will be recognized literally, rather than converted to a special character. For example    "`|"    
is the ASCII 124, "`^" is the "^" character, and "``" is a single backquote character because 
the first single backquote character protects the second one from being converted.

By pressing the More button, an Additional Response Strings dialog box will appear.    In 
this dialog box, you can specify up to seven (7)    additional response starting and ending 
locations with respect to    characters in the string.







Network Menu

Use this menu command to input the Local Station Name and Connection Attempts for 
connecting to the remote stations.

NETWORK SETTINGS DIALOG BOX

Local Station Name:
The Local Station Name is a unique name in the entire network for the current station. This 
case sensitive string will be used to uniquely identify this computer from all others in the 
same network. All printable characters except the space character can be used in the name 
string.

Connection Attempts: After connection, if a network block can not get any data from remote station after
it tries N times, then the network block will show timeout in the status bar. A zero (0) entry in this text box 
indicates that as many attempts as are necessary will be made for network connection.    Any other 
integer in the text box will allow for connection attempts to stop after N number of tries. 



Addtool Menu

Use this menu command to add user defined DLL as a new tool.

The DLL you specify    here should adhere to GENIE user defined tool guidelines. See GENIE 
EXTENDED FEATURES Users Guide for how to write a user defined DLL. The name and path 
of the new DLL will be written to the file GENIE.TOL    in the GENIE directory. This file will be 
used to load all user defined DLLs upon executing GENIE or GENIE runtime.

SQWAVE.DLL is an example user defined tool. You can use this tool to see how a DLL can be 
used to interface with GENIE. This feature extends the capability of GENIE to support any 
proprietary hardware device or to perform complex operations by letting users to write their 
module.



.View Toolbox Menu

Use this menu command to View the Icon Toobox.



Single Operator Calculation Block (SOC)

This block does single operator math computations, such as add, subtract, multiply, etc.    At least one 
block must be connected as an input block; this will be the first operand.    The second operand can be 
either another block, or a constant which is entered in the Single Operand Calculation block's dialog box. 

Once two operands are selected, the order can be switched by pressing the Swap Operands button in 
the dialog box.    This is important, since some operators, such as div or mod, will yield different results 
depending upon what values you use for OP1 and OP2 (first operand and second operand).      The first 
block that is connected to the Single Operator Calculation block will be defaulted to the first operator in 
the dialog box.      If you wish to have a different order, press the Swap Operands button, this will switch 
the order of operation of the SOC block.

The Result Data Type (output data type) can be either Floating Point (Real) or Integer.    

Single Operator Calculation Block Operators and Functions
Operator Function (Output)
nop Outputs 0 always
+ OP1 + OP2
- OP1 - OP2
x OP1 * OP2
/ OP1 / OP2
pow      OP1 ^ OP2
* mod Outputs remainder of OP1 / OP2
* and Logical AND of OP1 and OP2
* or Logical OR of OP1 and OP2
* xor Logical XOR of OP1 and OP2
max Outputs the maximum of OP1 and OP2
min Outputs the minimum of OP1 and OP2
>= Outputs 1 if OP1 >= OP2, 0 otherwise
<= Outputs 1 if OP1 <= OP2, 0 otherwise
> Outputs 1 if OP1 > OP2, 0 otherwise
< Outputs 1 if OP1 < OP2, 0 otherwise
equ Outputs 1 if OP1 == OP2, 0 otherwise
neq Outputs 1 if OP1 is not equal to OP2, 0 otherwise
abs Outputs the absolute value of OP1
* not Logical NOT of OP1
inv Outputs 1 / OP1 (inverse of OP1)
sqrt Outputs the square root of OP1
log Outputs the log of OP1 (base 10)
ln Outputs the natural log of OP1 (base e)
exp Outputs e ^ OP1
jct Junction block (see below)

Operators with an asterisk "*" next to them require an integer operand. 
Some of the above mentioned operators need only one operand, while others need two.    The logical 
operators (AND, OR, XOR) require two operands which must be integers.    Other operators (ABS, NOT, 
INV, SQRT, LOG, LN, EXP, JCT) only require one operand, which can be either integer or floating point 
format, depending on the operator. 

Some care is needed when providing input operands to certain operators.    The MOD and "/" operators 
cannot have 0 (zero) as an operand to avoid a divide-by-zero situation.    In the same way, some 
operators (SQRT, LN, LOG) require a positive value as an operand.    Runtime errors will occur if these 
rules are not followed.    



The JCT operator has a special function of simply outputting its input.    It's useful for connection between 
a button display item and many other blocks.    In the display editor, the button display item is designed to 
output to one and only one other block.    Use of the JCT operator allows you to connect the button display
item to many other blocks, by using the JCT operator as a branching point.    For this example, you would 
configure the button display item to output to the SOC block, and connect the display block to the SOC 
block (arrow pointing into the SOC block).    Then, configure the SOC block to function as a JCT, or 
junction.    You can now connect as many blocks as you wish to the SOC JCT block, and this in turn will 
give control of all of those daughter blocks to the single button.    



Hardware Event Counter/Frequency Measurement/Pulse Output Block

This block has input and output capability that supplies other blocks with Event Counter, Frequency 
Measurement, or Pulse Output information from the I/O device's counter/timer section. When this block is 
double-clicked upon, all I/O devices currently installed that have available counter/timer channels are 
displayed in an associated dialog box. When a device is selected,    all counter/timer channels for the 
device are displayed below it. You choose the hardware's counter/timer channel to be connected to a 
particular Counter/Frequency/ Pulse Output block by clicking on the desired device's channel.    

A hardware devices counter/timer chip is used as a hardware event or frequency counter that counts 
digital rising edges (digital high events) from an external source that supplies digital information (TTL or 
other level 1's and 0's). Also, the block may be used to control the output of the timer/counter chip (when 
supported by the driver) to be used as a pulse generator. The block's output can be sent to another 
block, such as to the display block. All counting or pulse output is performed by the I/O cards 
timer/counter chip, and is not dependent on the sample rate of the strategy. The event counter is 
implemented as an up - counter; that is, the count starts at 0 (zero) and counts until it reaches the 
counters maximum value (hardware/driver dependent). A down - counter may be constructed by using 
this block in conjunction with a User Program Block or Single Operation Calculation (SOC) block and 
subtracting the counter output from the maximum count.    In this way, the count will start at the maximum 
and will end at zero.

If the Start/Stop Input is connected, the counter or pulse generator is started and stopped by this input. 
This allows for total control over counter operation during runtime. If the start/stop input is not connected, 
the counter will start when the strategy begins and stop when it ends.To start the counter using the 
start/stop input, provide a rising edge (from low (zero) to high) to this input from another block. This will 
start the hardware counter from zero. Counter status is output from the counter/frequency/pulse output 
block with every scan of GENIE, unless the divisor (explained below) is set to a value other than 1 (one). 
By applying a falling edge (from high to low) digital value to the start/stop input, the counter may be 
stopped at the current value.

By connecting a rising edge value to the blocks Reset Input, the count can be reset to its starting value 
and counting is resumed. A falling edge value to the reset input will have no effect on counting (reset input
not connected is    treated as a low). 

Pulse Output Functions
To create a pulse generator output from the counter/timer section of the I/O device (if supported by the 
DLL driver),    you can specify the Total Period and first 1/2 cycle time (in seconds) by using either the 
static values you specify in the dialog box or by supplying the block with floating point values on its input 
by another block.    Not all I/O devices support a varying first 1/2 cycle due to hardware limitations of the 
counter/timer chip.    In this case,    when you specify a total period the device will generate a 50% duty 
cycle square wave on its output pin.    Check the DLL driver on-line help for specifications on hardware 
support.

If the Total Period Input is connected to a block that supplies floating point output such as the User 
Programmable Block, the total pulse time (1/frequency) of the pulse output is controlled by this input. This
allows for total control over total pulse frequency operation during runtime. If the Total Period input is not 
connected, the counter will use the static values entered in the dialog box when the strategy begins.

If the First 1/2 Cycle Input is connected to a block that supplies floating point output such as the User 
Programmable Block, the first 1/2 cycle time (1/frequency) of the pulse output is controlled by this input. 
This allows for total control over first 1/2 cycle pulse frequency operation during runtime. If the first 1/2 
cycle input is not connected, the counter will use the static values entered in the dialog box when the 
strategy begins.



External Gating -- the counter/timer chip may be started and stopped via external level control on a 
special input pin. If the hardware timer/counter and DLL driver supports external hardware gating, setting 
this value to high level or low level will enable the timer/counter chip to allow for gating control. Then, if 
the counter is started either at the strategy start or using the start/stop input, the actual counting connot 
take place until the external gate senses the proper level on its input pin.

The Update rate is a divisor which allows the Counter/Frequency/Pulse Output block to have a different 
effective scan rate than the rest of the strategy.    This is useful if, for example, your strategy is running at 
20Hz, but you only want to sample the counter at a rate of 4Hz.    For this example, you would set the 
Update Rate to 5 (20 divided by 5 (the update rate) gives an effective scan rate of 4Hz).    In this scenario,
you will still get 20Hz data if you send the output to a Log File block or a . display block, but only one in 
five samples will be "real".    The other samples are merely copies of the "real" sample.    Valid values for 
the update rate are between 1 and 32767.    

Note: A separate Counter/Frequency/Pulse Output    block is needed for each individual hardware 
counter/timer channel.



DDE Blocks (Client and Server)

DDE, or Dynamic Data Exchange, is a feature that is included in GENIE that allows you to exchange data
between GENIE and other Windows applications.      

There are two DDE blocks included in GENIE, known as DDE Server, and DDE Client.    In addition, there 
are five blocks that have DDE capability built into them.    These include the Analog Input, Analog Output, 
Digital Input, Digital Output, and Temperature Measurement blocks.    For these five blocks, DDE 
capability is accessed through the dialog box that appears when you setup the blocks.    

The DDE Server block provides data from GENIE to another Window application.        Since DDE 
uses a broadcast-type communication, the DDE server will "publish" its data, and other applications have 
the responsibility to find it and use it as they wish.    When a block is connected to the DDE server block 
with the connection wire, the link is made between that block, and double clicking on the DDE server 
block will tell you the name of the Service, Topic and Item.    This information is what the other 
applications will need to locate a link that you create in
GENIE.

The Service, in this case, is GENIE.    It is the program name of the Windows application that is 
providing the data.    

The Topic is the name of the particular file that is providing the data.    In GENIE, it would be the name 
of your particular strategy (*.GNI).    The extension (.GNI) is not needed here, only the name of the 
strategy.    For example, if your strategy is named DDEDEMO.GNI, the topic would be DDEDEMO.      
Keep in mind that an untitled strategy will not be able to provide data through DDE; it must be a unique, 
saved filename.

The Item is the tagname of the block that is providing the data(DDES1, DDES2, DDEC1, etc.).      Other 
valid tagnames are AI1, DO3, etc.    (first Analog input block, third digital output block, third elapsed timer 
block, etc.)    since the I/O blocks have DDE capability built-in to their dialog boxes.    It is important to 
realize that these are the tagnames that GENIE assigns to the particular blocks, and not the description 
that the user can change.    

These three fields are what the other Windows applications will be looking for.    Usually, most other 
Windows applications will separate the fields in the following manner:

Service|Topic!Item

However, this is not a universal standard, only common practice.    You should refer to the documentation 
for your particular Windows application to learn how DDE syntax is implemented for each program.

The DDE Client block receives data from another Windows application.      This block will require that 
you input the Service, Topic, and Item for the application that will be providing data to GENIE.    It may 
also be necessary for the other Windows application to be set up to publish data; you should refer to your 
documentation on the other Windows application for this information, as well as the quantities    Service, 
Topic and Item.

The DDE client block will receive data from another application, then input that data to the blocks that are 
connected to the DDE client block via the connection wire.    Any number of blocks can be connected to a 
DDE client block, and they can all use the data that the DDE client block is receiving from the server 
application.

To setup a DDE client block, your other application should be running in the background.    Place the DDE 
client block on the Strategy Editor workpad, and connect it to the blocks for which you wish to output data 
to (from the DDE client block; further,    from your other application).    Then, double click on the DDE client
block, which will invoke the DDE client dialog box.    Within this dialog box, click on the Connect... button. 



In the dialog box that appears (Create DDE Link), you should see your application name in the box under 
Service.    All of the applications that are currently running which have DDE capabilities will usually be 
displayed in the Service box, however, some applications will not be shown.    If the other applications are
listed, click once on the Service that you wish to use, which will then place the available Topics in the 
next box under Service Topics.    Click once on the appropriate topic, which will then place the available 
Items in the box under Topic Items.    Clicking on the OK button after going through this sequence will 
place the service, topic and item in the format 

Service|Topic!Item

in the Create DDE Link dialog box.    The link is now created and you can receive data from the other 
application.

If your other application's Service, Topic and Item is not shown in the list boxes and you want to exchange
data with them, you must manually enter the Service, Topic and Item in the appropriate Text Box within 
the DDE Client dialog box.

The DDE link can still be used after saving your strategy and restarting later.    If the server application is 
not running the next time you invoke the strategy, GENIE will ask you if you would like to start it.    For this 
to take place, the server application must be explicitly mentioned in the PATH= statement in your 
AUTOEXEC.BAT file.    If not, GENIE will not be able to start the server application.



DDE Blocks (Client and Server)

DDE, or Dynamic Data Exchange, is a feature that is included in GENIE that allows you to exchange data
between GENIE and other Windows applications.      

There are two DDE blocks included in GENIE, known as DDE Server, and DDE Client.    In addition, there 
are five blocks that have DDE capability built into them.    These include the Analog Input, Analog Output, 
Digital Input, Digital Output, and Temperature Measurement blocks.    For these five blocks, DDE 
capability is accessed through the dialog box that appears when you setup the blocks.    

The DDE Server block provides data from GENIE to another Window application.        Since DDE 
uses a broadcast-type communication, the DDE server will "publish" its data, and other applications have 
the responsibility to find it and use it as they wish.    When a block is connected to the DDE server block 
with the connection wire, the link is made between that block, and double clicking on the DDE server 
block will tell you the name of the Service, Topic and Item.    This information is what the other 
applications will need to locate a link that you create in
GENIE.

The Service, in this case, is GENIE.    It is the program name of the Windows application that is 
providing the data.    

The Topic is the name of the particular file that is providing the data.    In GENIE, it would be the name 
of your particular strategy (*.GNI).    The extension (.GNI) is not needed here, only the name of the 
strategy.    For example, if your strategy is named DDEDEMO.GNI, the topic would be DDEDEMO.      
Keep in mind that an untitled strategy will not be able to provide data through DDE; it must be a unique, 
saved filename.

The Item is the tagname of the block that is providing the data(DDES1, DDES2, DDEC1, etc.).      Other 
valid tagnames are AI1, DO3, etc.    (first Analog input block, third digital output block, third elapsed timer 
block, etc.)    since the I/O blocks have DDE capability built-in to their dialog boxes.    It is important to 
realize that these are the tagnames that GENIE assigns to the particular blocks, and not the description 
that the user can change.    

These three fields are what the other Windows applications will be looking for.    Usually, most other 
Windows applications will separate the fields in the following manner:

Service|Topic!Item

However, this is not a universal standard, only common practice.    You should refer to the documentation 
for your particular Windows application to learn how DDE syntax is implemented for each program.

The DDE Client block receives data from another Windows application.      This block will require that 
you input the Service, Topic, and Item for the application that will be providing data to GENIE.    It may 
also be necessary for the other Windows application to be set up to publish data; you should refer to your 
documentation on the other Windows application for this information, as well as the quantities    Service, 
Topic and Item.

The DDE client block will receive data from another application, then input that data to the blocks that are 
connected to the DDE client block via the connection wire.    Any number of blocks can be connected to a 
DDE client block, and they can all use the data that the DDE client block is receiving from the server 
application.

To setup a DDE client block, your other application should be running in the background.    Place the DDE 
client block on the Strategy Editor workpad, and connect it to the blocks for which you wish to output data 
to (from the DDE client block; further,    from your other application).    Then, double click on the DDE client



block, which will invoke the DDE client dialog box.    Within this dialog box, click on the Connect... button. 
In the dialog box that appears (Create DDE Link), you should see your application name in the box under 
Service.    All of the applications that are currently running which have DDE capabilities will usually be 
displayed in the Service box, however, some applications will not be shown.    If the other applications are
listed, click once on the Service that you wish to use, which will then place the available Topics in the 
next box under Service Topics.    Click once on the appropriate topic, which will then place the available 
Items in the box under Topic Items.    Clicking on the OK button after going through this sequence will 
place the service, topic and item in the format 

Service|Topic!Item

in the Create DDE Link dialog box.    The link is now created and you can receive data from the other 
application.

If your other application's Service, Topic and Item is not shown in the list boxes and you want to exchange
data with them, you must manually enter the Service, Topic and Item in the appropriate Text Box within 
the DDE Client dialog box.

The DDE link can still be used after saving your strategy and restarting later.    If the server application is 
not running the next time you invoke the strategy, GENIE will ask you if you would like to start it.    For this 
to take place, the server application must be explicitly mentioned in the PATH= statement in your 
AUTOEXEC.BAT file.    If not, GENIE will not be able to start the server application.







Network Input

To use this block, your network must support the IPX Protocol. This block has output (up to 8 
channels) capability.    Up to eight (8) values are received from a corresponding Network Out 
block on another node (Remote Station) running Genie.    The value(s) (string, float, or 
integer) sent from the Remote Station may in turn be routed to other strategy blocks or 
displays.        When this block is double-clicked upon, a dialog box will appear.    Connection 
status will show in the status bar during Runtime.

To execute the network feature, the user must setup the network setting in the SYSTEM.INI 
file in the Windows directory as follows:

[boot]
network.drv=netware.drv
or
secondet.drv=netware.drv

[386Enh]
network=vnetware.386,vipx.386
or 
secondnet= vnetware.386,vipx.386

You must run the network driver (ipx.com) before running WINDOWS. In addition, three files
must be present in your working directory or \WINDOWS directory: nwipxspx.dll, tli_spx.dll 
and tli_win.dll. The Genie setup program installs the three DLLs.

NETWORK SETTINGS DIALOG BOX

Local Station Name:
After making sure of your network settings as described above for each machine on your 
Genie Network,    you must enter the Setup/Network Menu to name each Station.

Connection Attempts: After connection, if a network block can not get any data from 
remote station after it tries N times, then the network block will show timeout in the status 
bar. A zero (0) entry in this text box indicates that as many attempts as are necessary will be
made for network connection.    Any other integer in the text box will allow for connection 
attempts to stop after N number of tries. 

NETWORK IN BLOCK DIALOG BOX

Remote Station Name:
Name of Remote Station from which data will be received.

Remote Block Name:
Name of Remote Network Out block from which data will be received.

Data Type:
Integer, Floating point (Real), or String Data types are supported.

NETWORK IN DEFAULT CHANNEL VALUES DIALOG BOX



User-defined default values for the eight channels of the Network Input Block: This means 
that the Network Input Block will output the default value when it does not receive any data 
from a remote station. The user can use this value to determine if the data from Network 
Input Block is correct data.

NETWORK IN CHANNEL SELECTION DIALOG BOX

Choose the remote stations channel from which to send data to another block in your local 
strategy.



Network Output

To use this block, your network must support the IPX Protocol. This block has input (up to 8 
channels) capability.    Up to eight (8) values are transmitted to a corresponding Network In 
block on another node (Remote Station) running Genie.    The value(s) (string, float, or 
integer) sent from the Strategy blocks may in turn be routed to a Remote Station        When 
this block is double-clicked upon, a dialog box will appear.    Connection status will show in 
the status bar during Runtime.

To execute the network feature, the user must setup the network setting in the SYSTEM.INI 
file in the Windows directory as follows:

[boot]
network.drv=netware.drv
or
secondet.drv=netware.drv

[386Enh]
network=vnetware.386,vipx.386
or 
secondnet= vnetware.386,vipx.386

You must run the network driver (ipx.com) before running WINDOWS. In addition, three files
must be present in your working directory or \WINDOWS directory: nwipxspx.dll, tli_spx.dll 
and tli_win.dll. The Genie setup program installs the three DLLs.

NETWORK SETTINGS DIALOG BOX

Local Station Name:
After making sure of your network settings as described above for each machine on your 
Genie Network,    you must enter the Setup/Network Menu to name each Station.

Connection Attempts: After connection, if a network block can not get any data from 
remote station after it tries N times, then the network block will show timeout in the status 
bar. A zero (0) entry in this text box indicates that as many attempts as are necessary will be
made for network connection.    Any other integer in the text box will allow for connection 
attempts to stop after N number of tries. 

NETWORK OUT BLOCK DIALOG BOX

Remote Station Name:
Name of Remote Station to which data will be sent.

Remote Block Name:
Name of Remote Network In block to which data will be sent.

Data Type:
Integer, Floating point (Real), or String Data types are supported.

Start/Stop from:
On/Off control for Network Output Block: Network Output Block has



one input to control data to be sent.    To start sending data, send a digital one to the block 
input from another block or display item, such as from a button.    If this input is not 
connected,    data will be sent upon runtime initialization. 



Numeric Control Display Item

A numeric-type control may be drawn and interfaced to control a Strategy Block variable with a certain tag
name. The size of the display may be chosen. This display item is used as an output from the keyboard or
mouse; data is to be sent to a Strategy block variable by an operator who specifies the data. By this 
method, Supervisory Control may be achieved. You choose whether the data is integer or real, and the 
display format -- how many digits and location of the decimal point (floating point format only). The 
amount of precision for all fields is determined by the initial value field.    The size and properties of the 
font used in this block can be changed    by pressing the Font... button in the Numeric Control Display 
Item dialog box.



 Button Display Item

A button display may be drawn and interfaced to a strategy Block variable with a certain tag name. The 
size of the display may be chosen. This display item is an output from the display -- the button is pressed 
by use of the mouse, and a digital 1 or 0 is sent to the tagged digital Strategy Block. The Button Display 
may also be toggled by use of the ENTER key, if the focus is currently on the Button.    (The focus, a 
standard Windows term,    refers to which display item currently can be controlled by the keyboard). Which
display item currently has the focus may be changed by use of the TAB key. In addition,    a hot key may 
be specified for pressing the button without changing the focus by changing the Keyboard Mapping 
parameter in the dialog box.    By this method, Supervisory Control may be achieved. 

The button display item is designed to output to one and only one block.    If you wish to connect the 
output of the button to more than one block, use the Single Operator Calculation block, configured in JCT 
mode.    For more information, consult the section entitled    "Single Operator Calculation Block".

The size and properties of the font used in the button text can be changed in this block by pressing the 
Font... button in the Button Display Item dialog box.



 Text String Display Item

A text string label may be entered for display purposes only. No interface to Strategy Block tag names is 
provided.    Within the Text String Display Item, you can choose the font, color and size of the displayed 
text by pressing the Font... button in the Text String Display Item dialog box.



 Group Box Display Item

A box or frame may be drawn around groups of other Display Items for enhancing the look of
your display. No interface with Strategy Editor blocks is provided. The box may be re-sized, as 
can the frame width.



XY Graph

The XY graph allows you to plot data from two separate blocks against each other.    The colors of the 
trace and background can be chosen, as well as the length of the trace.    Using a trace with a smaller 
number of points will use less machine memory, and your display will run much more efficiently.    

The graph style can be selected, giving you flexibility in your display, allowing you to show ticks and/or 
numbers on the axes.    Also, ranges for both axes can be selected, permitting you to make your display 
any size or scale.



Conditional Button Display Item

The Conditional Button Display Item has both input and output capability.    The output may 
be interfaced to a Strategy Block variable with a certain tag name. The button is pressed by 
use of the mouse, and a digital 1 or 0 is sent to the tagged digital Strategy Block. The 
Conditional Button Display may also be toggled by use of the ENTER key, if the focus is currently on the 
Conditional Button.    (The focus, a standard Windows term,    refers to which display item currently can be
controlled by the keyboard). Which display item currently has the focus may be changed by use of the 
TAB key. By this method, Supervisory Control may be achieved. The input may be interfaced 
to a Strategy Block variable with a certain tag name and is used for controlling the buttons 
status from the strategy (by sending a digital 1 or 0) instead of with the mouse. The size of 
the display may be re-sized with the mouse.

The button display item is designed to output to one and only one block.    If you wish to 
connect the output of the button to more than one block, use the Single Operator 
Calculation block, configured in JCT mode.    For more information, consult the section 
entitled    "Single Operator Calculation Block". 

The size and properties of the font used in the button text can be changed in this block by 
pressing the Font... button in the Button Display Item dialog box.





Historical Trending Display Item

A Historical Trending Display may be drawn and interfaced with one or many Strategy Block 
variable(s)    with a certain tag name or names. The size of the graph may be chosen.      A 
Historical Trending Graph displays data from up to 8 Strategy Blocks on the Y axis, against 
time on the X axis. 

You    need to choose which Strategy Editor block's data you would like to display, 
corresponding with your chosen trace colors. Available icon block tag names are displayed in
a list box labeled "Historical Trending Channel". Up to 8 blocks can be interfaced for display 
in one graph. By double-clicking on each desired icon block tagname,    tagnames are 
selected for graphical display. When blocks are selected, a double asterisk appears to
the left of the tagname.    As you select tagnames for display, you can choose separate 
trace colors for each tagname. The color for a trace is displayed and can be changed each 
time a selected tagname is highlighted with the mouse. 

The Historical Trending Display Item allows data logging to be started and stopped when the 
strategy is started and stopped. A single Historical Trending Graph can support up to eight 
(8) process variables corresponding with eight (8) strategy tag names.    Each Historical 
Trending Graph can write to one or more    log file(s).    Log files are binary files with a naming
convention as follows:

YYMMDD##.HST

where:

YY = Year file was created
MM = Month file was created
DD = Day file was created
## = Historical Trending Graph Number

The name of the file contains the strategy start date and Historical Trending Graph number.
Each log file can contain one or more Historical Sections. Each section corresponds with 
the time between the start and stop of a strategy, if the start/stop time is within the file 
date.    A new file will be created only when the strategy is stopped and then re-started after
the file date ends.

HIST Conversion Menu Item
Use this command to Convert the Historical Trending Display Item Log files from Binary to 
ASCII format after acquisition is complete in the GENIE Runtime System. When converting 
the format to ASCII,    you can then examine the contents using any standard ASCII editor.

The Historical Trending Graph allows different logging speeds to be applied to different files 
by setting the Number of samples for each graph point parameter in each Historical 
Trending Graph dialog box.    By setting the Number of graph points in one span 
parameter, the amount of displayed Historical Trending information can be changed.    The 
date/time for each span is displayed above the left/right sides of the graph.

The leftmost and rightmost buttons below the graph are used for moving to the previous
and next sections respectively. This allows you to view previously run strategy information. 
The second button from left and right    allow you to scroll the graph 1/2 span in either 
direction. The third button from left and right    allow you to scroll the graph 1/4 span in 
either direction. The Middle button allows you to view the most current Historical 



information (what is being sent to the logfile at this moment). This is where the Historical 
Trend is initialized upon strategy startup. The buttons are toggled by use of the mouse. The buttons 
may also be toggled by the keyboard ENTER key, if the focus is currently on the button to be pressed.    
(The focus, a standard Windows term,    refers to which display item currently can be controlled by the 
keyboard). Which display item currently has the focus may be changed by use of the TAB key.

Note:
When a Historical trend is started and    stopped and    more than 15 days have gone by 
before re-starting,    Historical information will be lost;    that is the Historical Trending cannot 
be retrieved if there is a gap in time of more than 15 days before strategy re-start. Also, a 
maximum of 50 days can be examined in one historical trend file.

HISTORICAL TRENDING DISPLAY ITEM DIALOG BOX

Number of Samples for Each Graph Point
A divisor similar to the Update Rate in many blocks. For each point in the Historical Trending 
Graph, you can specify how many actual strategy samples will pass before the point is 
displayed. 

Number of Graph Points in One Span
Specify the total number of Graph Points that will be displayed at once. (the Span of the 
graph)

Show Grid
Specify    whether or not to display the grid.

Vertical/Horizontal Resolutions
Specify    how many Tics between each grid line.

# of Tics
Specify how many Tics for the vertical (Y axis) will be displayed.

Start Tics
Specify the    Tics start number.

End Tics
Specify the    Tics ending number.

.





Hi Speed Logging Display Item

This block is primarily used to display and record the data coming out of the hi-speed analog
input (FAI) block. It cannot be used to log any other data type such as integer or floating 
point number. A Hi-Speed Logging Display may be drawn and interfaced with one or many 
Strategy Block variable(s)    with a certain tag name or names. The size of the graph may be 
chosen.      A Hi-Speed Logging Graph displays data from any number of Hi-Speed Analog 
Input Strategy Blocks on the Y axis, against time on the X axis. 

You need to choose which Strategy Editor block's data you would like to display, 
corresponding with your chosen trace colors. Available icon blocks are displayed in a list box 
labeled "Hi-Speed Logging Channel". Up to 8 blocks can be interfaced for display in one 
graph. By double-clicking on each desired icon block tagname,    tagnames are selected for 
graphical display. When blocks are selected, a double asterisk appears to the left of 
the tagname.    As you select tagnames for display, you can choose separate trace colors 
for each tagname. The color for a trace is displayed and can be changed each time a 
selected tagname is highlighted with the mouse. 

The Hi-Speed Logging Display Item allows data logging to be started and stopped when the 
strategy is started and stopped. A single Hi-Speed Historical Trending Graph can support up 
to eight (8) hi-speed analog input process variables corresponding with eight (8) strategy tag
names.    The Hi-Speed Logging Graph writes to the log file named FAIXX.DAT, where XX = 
Hi-Speed Logging Graph number. 

FAI Conversion Runtime Menu Item
Use this command to Convert the file (FAIXX.DAT, where XX = HI-Speed Logging Graph 
number) format from Binary to ASCII after acquisition is complete when using the HI-Speed 
Logging Display Item in the GENIE Runtime System. When converting the format to ASCII,    
you can then examine the contents using any standard ASCII editor.

By setting the Chart Span parameter, the amount of displayed Historical Trending 
information can be changed.    The date/time for each span is displayed above the left/right 
sides of the graph. By setting the Static Span, a fixed number of samples will be displayed
per graph span. Optionally,    you may set the graph span on the fly by setting the 
Dynamic Span from an external block or display item, such as from a Numeric Output 
Display Item. Specify the block or display item from which the Dynamic Span information is 
to come.

The center button is enabled during high speed data transfer only (not when high 
speed operations have ceased or have been stopped intentionally),    and is used to display 



one graph span of the most recently acquired data. 

The following buttons may only be pressed if high speed operations have been halted.   
High speed analog input blocks (FAI) that have been connected to the Hi-Speed Logging 
Display Item may be controlled by the use of a digital line connected to the FAI block input.    
A digital one (1) starts hi-speed operations from the I/O hardware,    and a digital zero (0) 
stops high speed operations. The digital start/stop to the FAI block input may be 
implemented with the Button Display Item or by any other digital icon block.    As stated 
above, the following buttons may be accessed after high speed acquisition has been 
stopped.    The leftmost and rightmost buttons below the graph are used for moving to 
the previous and next graph spans.    The second button from left and right    allow you 
to scroll the graph 1/2 span in either direction. 

The buttons are toggled by use of the mouse.    The buttons may also be toggled by the keyboard ENTER
key, if the focus is currently on the button to be pressed.    (The focus, a standard Windows term,    refers 
to which display item currently can be controlled by the keyboard). Which display item currently has the 
focus may be changed by use of the TAB key.

HI-SPEED LOGGING DISPLAY ITEM DIALOG BOX

Chart Span
Specify how many actual strategy samples per graph span.

Dynamic Span from
Specify the icon block or display item tag name from which dynamic span information should
be routed.

Show Grid
Specify    whether or not to display the grid.

Vertical/Horizontal lines interval
Specify    how many Tics between each grid line.

# of Tics
Specify how many Tics for the vertical (Y axis) will be displayed.

Start Tics
Specify the    Tics start number.

End Tics
Specify the    Tics ending number.





Knob Control Display Item

A numeric-type knob control may be drawn and interfaced (Output) to control a Strategy 
Block variable with a certain tag name. The size of the display may be re-sized. This display 
item is used as an output from the mouse; data is to be sent to a Strategy block variable by 
an operator who specifies the data. The knob may also be turned by the keyboard UP and DOWN 
arrow keys, if the focus is currently on the knob to be turned.    (The focus, a standard Windows term,    
refers to which display item currently can be controlled by the keyboard). Which display item currently has
the focus may be changed by use of the TAB key.

By this method, Supervisory Control may be achieved. The data is in real (floating point) 
format, and the display format may be chosen -- ie. how many digits and location of the 
decimal point. The size and properties of the font used in this block can be changed    by 
pressing the Font... button in the Knob Control Display Item dialog box.

KNOB CONTROL DISPLAY ITEM DIALOG BOX

Display Current Value
Specify whether the numeric display below the knob is active or not.    

Knob Action
Specify the knob action -- either smooth or incremental.

Decimal Places
Specify the desired number of decimal places after the decimal point.

Initial Value
Specify to which numeric value the knob will point at Runtime Startup.

Show Tics
Specify whether Tics will be displayed.

Start Tics 
Specify the lowest number    the knob will output-- ie. where the Tics will start.

End Tics
Specify the highest number the knob will output -- ie. the Tics ending number.

Tics Rate



Specify rate at which the    Tics will increment.



Runtime

The GENIE Runtime system allows simultaneous execution of control, graphics, alarming, 
trending, datalogging, file transfer, and multiple I/O drivers. Its purpose is to execute 
strategies created in the GENIE Strategy Editor and Display Editor. 

Runtime Operation

The GENIE Runtime system behaves in different ways, depending on the choices made by 
the designer who created the strategy and corresponding displays. Its overall behavior is 
determined by the way in which Strategy Editor blocks have been arranged and connected, 
in conjunction with the Scan Period(s) set in the SETUP/TASKS menu. (Refer to the Setup 
Menu section in Chapter 2.2.3:Strategy Editor Menu Bar)    If the Display has been designed 
with output capability -- buttons, numeric displays that can be edited, etc., the associated 
parameters can be changed during GENIE Runtime. Most commands and data are entered 
using the keyboard or via the mouse, which are both functional during GENIE Runtime.

Starting Runtime

Starting the GENIE Runtime session is performed from WINDOWS, DOS, or from the 
GENIE Strategy Editor menu bar.

1)    If Running from WINDOWS, enter the Advantech GENIE group, and double-click on the 
GENIE Runtime icon. Open the desired strategy file with the suffix ".gni", and press START on
the GENIE Runtime Menu Bar. 

2)    If running from the DOS prompt, type:

win gwrun <strategy>

where strategy is the name of the strategy.gni file that was designed with the Strategy 
Editor. Make sure that the GENIE\STRATEGY directory is in your path (autoexec.bat).

3) You can also create a new icon with GWRUN <strategy> as the command line. This will 
cause the strategy to be loaded and started upon running.

4)    If running from the Strategy Editor menu bar, after you have saved the currently 
displayed strategy, press "RUN" with your mouse.

Runtime Menu Bar

The Runtime Menu Bar consists of a number of menus that enable you to manipulate files, 
start or stop running your strategy,    or manipulate windows. There is also on-line help 
available through a help menu.

Runtime Menus
File Menu
Start Menu item
Stop Menu item
Resume Menu item



Pause Menu item
Lock Menu item
Window Menu
Help Menu

Following is a description of the Runtime menus:

File Menu

The File menu includes commands that enable you to open and close    existing GENIE 
Strategy Files. Commands include:

Open
Use this command to Open an existing strategy. Normally, existing strategies will be stored 
in the GENIE directory.

Close
Use this command to Close your strategy. Make sure that you save it first.

FAI Conversion
Use this command to Convert the file (FAIXX.DAT, where XX = HI-Speed Logging Graph 
number) format from Binary to ASCII after acquisition is complete when using the HI-Speed 
Logging Display Item in the GENIE Runtime System. When converting the format to ASCII,    
you can then examine the contents using any standard ASCII editor.

HIST Conversion
Use this command to Convert the Historical Trending Display Item Log files from Binary to 
ASCII format. These files have a naming convention as follows:

YYMMDD##.HST

where:

YY = Year file was created
MM = Month file was created
DD = Day file was created
## = Historical Trending Graph Number

after acquisition is complete in the GENIE Runtime System. When converting the format to 
ASCII,    you can then examine the contents using any standard ASCII editor.

SCRIPT
Use this command to Run a Script.    The    Scripting Language feature is a critical part of 
GENIE 2.0+ that sets it apart from other icon-based data acquisition and control programs.    
The Scripting Language will allow you to step GENIE through separate strategies and various
stages of your process, experiment, or test without operator intervention.

Ramp and soak cycles can be implemented for batch control applications.    Disk logging can 
be turned on and off automatically at certain points in the automation sequence.    Valves 
can be opened and closed.    If an emergency condition takes place,    the script can be made 
to branch to a specific shutdown strategy.

Using any standard ASCII editor, such as the GenPad Script Editor (icon interface provided in 



GENIE program group), you can write a script that acts on your GENIE Strategies and    User 
Program block variables within the Strategies, with one or many lines of program 
statements. The scripting language uses C-like syntax as does the User Program block and, 
in fact, shares variables with the User Program block(s) in your Strategies.

Script
A Script consists of one or more statements that follow the correct syntax. The script runs 
during GENIE Runtime like a batch file -- that is, it performs each line in sequential order. 
Function calls are made one at a time,    and each function must be completed before the 
next line is executed in the script. Check the GENIE Reference Manual, EXTENDED Features 
for detailed information on Scripting Language syntax.

Exit
Use this command to Exit the GENIE Runtime System.

Start Menu Item

A command that enables you to start your strategy as soon as you press "start".

Stop Menu Item

A command that enables you to stop your strategy as soon as you press "stop".

Resume Menu Item

A command that enables you to Resume your strategy after previously Pausing.

Pause Menu Item

A command that enables you to pause your strategy temporarily, to be continued at the 
same spot at a later time.

Lock Menu Item

A command that enables you to "lock" your strategy from inputs from the keyboard or 
mouse.    Refer to section 2.2.3, "Strategy Editor Menu Bar" under the section 
Setup/Runtime Preference for information on setting a password.    

To "unlock" a "locked" strategy, press the ESC key, followed by typing the password that was
chosen in Setup/Runtime Preference.    If no password is selected in Setup/Runtime 
Preference, then simply pressing the ESC key will "unlock" the strategy.

Window Menu

The Window menu includes commands that enable you to arrange multiple windows within 
GENIE. You can also select between a Runtime Window, Strategy Editor Window or a Display 
Window for a chosen file here. 



Runtime Toolbar

To display or hide the Toolbar at the top of the Strategy Editor    screen    , highlight the 
View/Toolbar command with your mouse. The Toolbar and its associated buttons allow you to
perform certain menu operations more quickly than actually going through the menus.    
Button commands are as follows:

Open an Existing Strategy

This button opens an existing strategy file.

Close the Current Strategy

This button closes currently displayed strategy.

Printer Setup

This button displays the print setup dialog box.

Start Runtime

This button starts the strategy running.

Stop Runtime

This button stops the currently running strategy.

Resume Runtime

By pressing this button, runtime may be resumed after first pausing.



Pause Runtime

Pressing this button pauses runtime until the Resume button is pressed.

Select Display

A series of buttons that allow you to toggle between defined displays in your strategy.    Up 
to eight displays may be accessed through the buttons.    The displays are defined 
numerically by their label in the Strategy Editor.

Context Sensitive Help

This button changes the mouse cursor to a special help cursor that allows you to select an 
object and display help for clicked buttons, menus, and windows. 

Runtime Status Bar

To display or hide the Status Bar at the bottom of the Runtime screen, highlight the 
View/Status Bar command with your mouse. The Status Bar allows you to get quick, concise 
help on menu commands.    As you highlight a menu item with your mouse, you can view 
information on the item in the status bar at the bottom of the runtime window. Also during 
runtime,    status information is displayed such as any errors that have occured, or whether 
the strategy is running normally.    Errors generally include hardware driver errors or errors 
due to timing problems.    The error codes are listed in the Appendix under Runtime Error 
Code Listing.

Exiting GENIE Runtime
When you have finished working in Runtime exiting back to WINDOWS/DOS/GENIE is performed by 
pressing the STOP menu item on the Runtime menu bar. After you stop the runtime system, you can 
either re-start by pressing start, or you can exit the GENIE Runtime system by entering the File menu and
pressing Exit.



Start Menu item

A command that enables you to start your strategy as soon as you press "start".



Stop Menu item

A command that enables you to stop your strategy as soon as you press "stop".



Resume Menu

A command that enables you to Resume your strategy after previously Pausing.



Pause Menu item

A command that enables you to pause your strategy temporarily, to be continued at the same spot at a 
later time.



Lock Menu Item

A command that enables you to "lock" your strategy from inputs from the keyboard or mouse.    Refer to 
section 2.2.3, "Strategy Editor Menu Bar" under the section Setup/Runtime Preference for information 
on setting a password.    

To "unlock" a "locked" strategy, press the ESC key, followed by typing the password that was chosen in 
Setup/Runtime Preference.    If no password is selected in Setup/Runtime Preference, then simply 
pressing the ESC key will "unlock" the strategy.



Building a Strategy
Before you can use GENIE to run a process strategy interactively with its corresponding operator displays
in real time, you must first develop a strategy and design the corresponding operator panel(s). GENIE 
consists of three modules: GENIE Strategy Editor, Display Editor, and Runtime, that are used to 
accomplish these tasks.

After entering the GENIE program, thereby entering the Strategy Editor (invoked first because the 
process strategy is the basis of your process control/monitoring), you will see a Toolbox displayed to the 
left of the blank Strategy Editor screen. The icons in the Toolbox provide the means for all strategy 
development and configuration.

Using the Toolbox to Select Blocks

By simply clicking on the desired icon, the respective function is enabled. Using the mouse, these icon 
blocks are applied in developing the logic that will be used for interaction with your process. the large area
to the right of the icon Toolbox (actually, the Toolbox is a pop-up window that can be displayed or moved 
anywhere on the screen -- normally to the left) is the Strategy Editor work area. All Strategy Editor Block 
related operations, e.g. placement, sizing, moving, connections, etc. are made in that area.

A strategy is developed by clicking on the desired icon block, pointing the mouse to the desired spot in the
work area, and clicking the mouse again to "drop" the block at that location. Then the block must be 
connected to other block(s) and then finally, configured. 

When all of the blocks necessary to perform the desired process application have been placed, 
connected, configured, and saved, operator displays can be designed where Display Items are 
dynamically attached to the strategy variables.

 Connecting Blocks

All block connections are made while the Connect function is enabled. Enabling the Connect function is 
accomplished by moving the mouse cursor inside the Connect icon (the angled wire) and clicking the left 
mouse button. When the function is enabled, a "roll of wire" appears instead of the standard mouse 
cursor. In this mode, connections can be started and terminated between various Strategy Editor blocks. 
All connections are shown as solid blue lines, with dots at every corner. Blocks are connected by means 
of the mouse and the "roll of wire" icon.

To connect icons:
Move the cursor inside the desired source block (a block from which data will flow) and click the left 
mouse key. A connection line emanates from the source block. Moving the mouse causes the line to 
grow/shrink and move about the perimeter of the block.    The line is always perpendicular to the block. 
Clicking on the left mouse key causes the current line segment to be anchored. This feature allows you to
lay down line segments as you require, i.e. to move around other blocks or connections. Keep laying 
down connection line segments until you arrive at the destination block (a block that accepts data as an 
input). This should produce a blue "wire" that connects the two blocks if the connection is valid. Otherwise
a message box error message will appear, informing you that you cannot make the specified connection 
and the reason for the error (you may be trying to connect two blocks that only have an output, etc.). 
Keep repeating this procedure until all the necessary connections have been made. Blocks should be 
interconnected so as to form a logical flow, duplicating the signal flow in your process. Connect a Display 
icon wherever you would like to monitor/control the output/input of/to a block. When you're satisfied with 
the connections you have made, save the strategy.    

Once the blocks have been connected, they need to be configured



. 
Configuring Blocks

After you have completed the block connection process the final step in configuring your process strategy,
configuring the blocks, can begin. Once all blocks are connected, they must be configured by double-
clicking on each icon and setting configuration information in each associated dialog box. 

Entering strategy block parameters is accomplished by simply entering the appropriate parameter values 
from the keyboard into the necessary fields, or selecting/scrolling values with the mouse.    Each block is 
initially displayed with default values that can be overwritten with your desired values. The arrow cursor 
with the mouse button and/or the [Tab] key is used to move around to the various parameter fields in each
configuration dialog box.    When you have entered all of the desired parameter values for the current 
block, pressing the OK button, or pressing the [Enter] key incorporates the contents of the block's 
configuration menu into the strategy database. Pressing the CANCEL button ignores all parameter edits 
made and restores them to their previous values. The configuration information is saved into the strategy 
database whenever the strategy is saved. Once a block has been configured, its configuration parameters
can be viewed and edited at any time. Just double-click. 

Saving and Loading Your Strategy

The Strategy Editor provides a simple means for saving and loading strategies to and from your hard disk.
The File menu on the left side of the menu bar is used to accomplish both of these functions. If you are 
familiar with conventional Windows functions, you have already become familiar with the GENIE File 
function. Clicking on File on the menu bar when in the Strategy or Display Editor with the left mouse key 
will invoke the File submenu. This will allow you to use Save to save the strategy if already named, or use
Save As if naming or re-naming a strategy file. Strategy files always have the extension gni for GENIE. 
For instance, you could name your strategy file "test.gni".

Saving the Strategy
Periodically, or whenever a significant amount of work has been completed in the current strategy, it is 
advisable that the strategy be saved to disk to insure that the work is stored in the event of an accident. If 
the strategy has never been saved or if you desire to save the strategy under a different name, use the 
Save As command and enter the path (if the file will reside in a directory other than the GENIE directory) 
and file name of the strategy in the edit box provided. Or just type the file name after using your mouse to 
choose the path to the file, which is displayed on the right in the Save As dialog box. When satisfied with 
your entry, press the OK button with your mouse, or simply press [Enter]. Your GENIE strategy file will 
now be saved, and you can continue design or exit the Strategy Editor to later resume work.

If the strategy has been named and saved to disk before, to save the current work, simply click on Save 
with your mouse. The strategy will be saved under the name chosen before. 

Loading a Strategy
When GENIE is invoked, the strategy worked on most recently will automatically be loaded and displayed.
Should you need to load a different strategy from the disk into the Strategy Editor, the File submenu's 
Open function provides the tools to accomplish this task.

To open an existing file, Click on OPEN in the File menu. This will invoke a dialog box that will allow    you 
to either type in the path and filename of the "gni" file you wish to open into the edit box provided, or to 
click through the directory path until the desired filename appears in the filename box. Highlight your 
choice. Once you're satisfied with your entry, press OK, double-click on the entry, or press [Enter]. The 
strategy will then be displayed.

If changes were made to a strategy currently displayed, when the Open function is invoked, a message 
box will appear, prompting you to save the current changes before the new strategy can be loaded.

Should you desire a fresh screen, or a new strategy is to be designed, the File submenu's New function is



the tool to be used. 

Modifying Your Strategy

During your strategy editing process there will be times when you need to make changes. The Edit menu 
provides functions that allow you to modify your strategy quickly and easily.

Selecting Strategy Editor Items
Items in the Strategy Editor and Display Editor can be "selected" to perform various operations, either 
separately, or in groups. When an item is selected, enlarged black squares appear either on the perimeter
of an icon or display item (see below), or along a wire connection.

To select an item, simply point to the item with the mouse and click. The aforementioned enlarged 
squares should then appear.

To select multiple items, "grab" or select the items you wish to select by pointing your mouse 
somewhere outside the group of items you wish to select. Press the left mouse button, and as you hold 
down the button, drag the pointer diagonally across the items. You will see a box form around the items. 
When the box is around the desired items, let go of the mouse button. When items are selected properly, 
there will be heavy black squares at the corners of all selected items. Now you can perform commands on
selected items. All items remain selected until another mouse operation (click) is performed. 

To select all items in the currently displayed strategy, the Edit submenu function Select All may be clicked
upon. 

Moving Selected Items
To move one or many selected items in the GENIE Strategy Editor, press the left mouse button as you 
point to one of the selected items. As you hold down the left button, drag the selected items to the desired
location, and let go of the mouse button when the location is reached.

Deleting
The Delete function in the Edit submenu allows you to perform the operation of deleting any number of 
selected items. Simply select items using the above procedure, and then click on Delete, or press the 
[Del] key. Clicking on this command will cause all previously selected items to be erased (after a prompt 
asking you if you're sure).

Copying
To Copy items in GENIE, select items that you wish to copy (see above, Selecting Items).Then point your 
mouse to the copy command and press the left mouse button. This will copy the selected items into a 
buffer. The items may now be "Pasted" to another location by pressing "Paste" in the Edit menu. The 
selected items are now copied to the upper left of the screen area with new tag names. Now they may be 
moved to the desired location as a group, since they are all selected. Refer to the Moving Selected 
Items section above for instructions on moving groups of items.

Exiting the Strategy Editor

When you have finished your work in the Strategy Editor and desire to return to Windows or DOS, clicking
on the Exit command in the File submenu will accomplish this task. You will be prompted as to whether 
you would like to save any changes that were made in the current session. Upon giving the appropriate 
response, you will exit the Strategy Editor -- thus exiting the GENIE program.





Conditional Text Display Item

This display item has input and output capability.    It accepts a value between zero (0) and 
seven (7) from a strategy block, each value providing    capability to select text to be 
displayed.    Also, the string may be output to a block accepting a string as input, such as to 
the RS-232 block.    When this display item is double-clicked upon, a dialog box will appear 
displaying all text currently installed.    

Displayed Text
Specify the Text file to be selected corresponding with the currently highlighted Input Value.

Text/Background Color
Specify the Text and Background color for the currently highlighted Input Value.

Alignment
Specify the Text Alignment for the currently highlighted Input Value.



Building a Display

Double-clicking on a Display Block when in the Strategy Editor will invoke the Display Editor. The typical 
procedure for developing operator display panels from within the GENIE Display Editor consists of:

1)    Use the Toolbox to get desired Display Items with your mouse and place them on the screen at the 
desired locations.

2)    Change the size of the Display Item by pointing to one of the black squares on the Display Item's 
edge with your mouse. While holding down the left mouse key, drag the edge until the desired size is 
attained.

3)    Configure each Display Item by double-clicking anywhere on its surface. A dialog box will appear 
where you can choose which Strategy Editor block's data to dynamically display (or control, if supported).

4)    Add Group Boxes and Text to the display panel to relate static display information.

5)    If you desire a background to your display, you can use a previously designed bitmap picture as a 
background, similar to Windows Wallpaper.    
Select File/Attach Bitmap from the Display Editor Menu Bar to load a bitmapped picture to the current 
display.    You can then place display items on top of the bitmap to enhance your display.      

6)    Save the Display.

Creating Displays

To create a display, Display Items are arranged on the screen as you would like them to look when 
running your strategy. Basically, you get the Display Items from the Toolbox on the Display Editor screen 
-- whichever item fits your strategy. When placing the Display Items upon the screen, you can re-size 
them by placing your mouse pointer on one of the black squares (Display item's edge) and dragging while
the mouse button is still pressed. Once sized, you must configure the Display item by double-clicking 
anywhere on the Display Item. A dialog box will appear, where you can configure the Display Item, 
dynamically linking it to display/control a tagged Strategy Editor block's data.



KEvent Log Menu

Use this menu to enable the Event Log Viewer.    This allows you to view events such as :

1) Login/out times
2) Strategy Start and Stop times
3) Alarms and Alarm Acknowledgement

Event Log Viewer/Alarm Acknowledgement Dialog Box

While the strategy is running, alarms may be acknowledged by double-clicking on the Alarm Log Event 
(ALOG1 HI, etc. below). Alarms will be in the color red until acknowledged. For the Event Log dialog box 
to appear during Runtime, you must enable it via the View Menu. 



Hardware Alarm Block

This block has output capability that supplies other blocks with hardware alarm status from the I/O 
device's alarm section. When this block is double-clicked upon, all I/O devices currently installed that 
have available hardware alarm channels are displayed in an associated dialog box. When a device is 
selected,    all alarm channels for the device are displayed below it. You choose the hardware's alarm 
channel to be connected to a particular Hardware Alarm block by clicking on the desired device's channel.

The Hardware Alarm block outputs one of three levels:

0 = No Alarm has occured
1 = Low Alarm is is now set
2 = High Alarm is now set

If the Enable/Disable Input is connected, the alarm is enabled and disabled by this input. This allows for 
total control over alarm operation during runtime. If the enable/disable input is not connected, the alarm 
will be enabled when the strategy begins and be disabled when it ends.To enable the alarm using the 
enable/disable input, provide a rising edge (from low (zero) to high) to this input from another block. Alarm
status is output from the hardware alarm block with every scan of GENIE, unless the divisor (explained 
below) is set to a value other than 1 (one).    By applying a falling edge (from high to low) digital value to 
the enable/disable input, the alarm may be disabled.

By connecting a rising edge value to the blocks Reset Input, the alarm can be reset to zero and alarm 
operation is resumed. A falling edge value to the reset input will have no effect on the hardware alarm 
(reset input    not connected is    treated as a low). 

The Update rate is a divisor which allows the Alarm block to have a different effective scan rate than the 
rest of the strategy.    This is useful if, for example, your strategy is running at 20Hz, but you only want to 
sample the alarm status at a rate of 4Hz.    For this example, you would set the Update Rate to 5 (20 
divided by 5 (the update rate) gives an effective scan rate of 4Hz).    In this scenario, you will still get 20Hz
data if you send the output to a Log File block or a display block, but only one in five samples will be 
"real".    The other samples are merely copies of the "real" sample.    Valid values for the update rate are 
between 1 and 32767.    



Conditional Wavefile Block

This block has input capability.    It accepts a value between zero ()) and seven (7) from 
another block, each value providing    capability to select a wavefile to be played via a sound
card during runtime. When this block is double-clicked upon, a dialog box will appear 
displaying all wavefiles currently installed.    

CONDITIONAL WAVEFILE DIALOG BOX

Wavefile Name
Specify the wavefile to be selected with the currently highlighted Input Value. Enter the full 
path, or Browse to locate the desired wavefile.



Installing a Device
This section describes how to install and configure your I/O hardware drivers, using Advantech I/O device 
drivers.

If, when you installed the GENIE program, you checked the option box to "Install Drivers", the 
instructions in the following Installing DLL's within Windows 3.1    were performed automatically 
by the GENIE setup program. The instructions in Installing Each I/O Device Instance must be 
performed for each I/O device you wish to install.The section Installing DLL's within Windows 3.1 
should be used for future driver releases only, or if you intend to re-install the Advantech DLL(s) 
within Windows.

Installing DLL's within Windows 3.1

To set up an I/O device, a device driver (DLL) must first be installed outside of the Device Installation 
(DEVINST) program for the corresponding I/O device. Only one device driver is installed for each I/O 
device, but the driver can be accessed by many I/O devices (device instances) of the same type. 

To install a device driver (DLL) in WINDOWS, you must access the CONTROL PANEL in the MAIN 
Window. When in the Control Panel window, Click on the Icon    marked "DRIVERS". Choose the ADD 
button, and highlight the entry in the list box "Unlisted or Updated Driver". Press the OK button, and insert
a floppy or name the path to the location of the device driver you wish to install. Once the driver is 
installed, you should see that it is now listed.    There should be only one instance of each type of I/O 
device or board installed in WINDOWS. Once each device is installed, it remains installed unless you 
remove it by using the REMOVE button in the DRIVERS dialog box. Now you can enter the Advantech 
Device Installation Program (DEVINST) to install and configure each instance of that I/O device driver you
installed.

Installing Each I/O Device Instance

To Add and Set up each I/O device within the Advantech Device Installation program, go into the 
SETUP menu, and click DEVICE. You will notice a dialog box used to set up I/O devices.    Choose the 
ADD button, and you should see a pop-up box (List of Devices) containing a list of the device driver 
type(s) you just installed (or were installed automatically during GENIE setup). Highlight the desired 
device and press INSTALL, or double click on the device. This will bring you to a device specific dialog 
box that allows you to software-configure the device. Configure the device, and when you're satisfied with
your entries, press OK. This will bring you back to the I/O Device Installation dialog box, where you can    
add another I/O device (double click, or INSTALL). You can install as many I/O devices as you want    (you
are only restricted by your hardware and memory).    When you have completed your device installation 
and setup, there should be a listing reflecting your installation displayed in the I/O DEVICE 
INSTALLATION dialog box. Once an I/O device is Installed, you may change its parameters by either 
double clicking on its entry in the INSTALLED DEVICES list box, or highlighting and pressing the Setup 
button.



Setting Up or Configuring a Device
To Set up or Configure/re-configure each I/O device within the Device Installation program, go into the 
SETUP menu, and click on DEVICE. Highlight the previously installed I/O device you wish to set up,    and
press the Setup button. This will bring you to a device-specific dialog box that allows you to configure or 
re-configure the    device. Configure the device, and when you're satisfied with your entries, press OK. 
This will bring you back to the I/O DEVICE INSTALLATION dialog box, where you can see a displayed list
(Installed Devices) reflecting your I/O device configuration.

Adding a Device
To ADD and set up each I/O device in the Device Installation    program, go into the SETUP menu, and 
click DEVICE. Choose the Add button, and you should see a pop-up box (List of Devices) containing a list
displaying the device driver type(s) you have previously installed (or were installed automatically during 
GENIE installation/setup). Highlight the device and press INSTALL, or double click on it. This will bring 
you to a device-specific dialog box that allows you to configure the new device. Configure the device, and 
when you're satisfied with your entries, press OK. This will bring you back to the List of Devices box, 
where you can    add another I/O device of the same type (double click, or INSTALL). When you have 
completed your device installation and setup, there should be a displayed list reflecting all installations in 
the I/O DEVICE INSTALLATION dialog box.

Removing a Device
To Remove a previously set up    I/O device    within the Device Installation program, go into the SETUP 
menu, and click DEVICE. Highlight the device instance you wish to remove in the I/O DEVICE 
INSTALLATION dialog box, and then press the REMOVE button. You should see that the device has 
been removed at this time. When you have completed your device installation and setup, there should be 
a displayed list reflecting all installations and removals. The Remove button in the I/O DEVICE 
INSTALLATION dialog box will only remove each instance of the I/O device -- not the DLL driver itself. 







Slider Control Display Item

A numeric-type slider control may be drawn and interfaced (Output) to control a Strategy 
Block variable with a certain tag name. The display and slider size may be chaneged. This 
display item is used as an output from the keyboard or mouse; data is to be sent to a 
Strategy block variable by an operator who specifies the data. The slider may also be moved by 
the keyboard UP and DOWN arrow keys, if the focus is currently on the slider be moved.    (The focus, a 
standard Windows term,    refers to which display item currently can be controlled by the keyboard). Which
display item currently has the focus may be changed by use of the TAB key. By this method, 
Supervisory Control may be achieved. The data is in real (floating point) format. 

SLIDER CONTROL DISPLAY ITEM DIALOG BOX

Slider Action
Specify the slider action -- either smooth or incremental.

Initial Value
Specify to which numeric value the slider will point at Runtime Startup.

Show Tics
Specify whether Tics will be displayed.

Tics Start
Specify the lowest number    the slider will output-- ie. where the Tics will start.

Tics End
Specify the highest number the slider will output -- ie. the Tics ending number.

Tics Number



Specify how many total Tics will be displayed.    This entry will be greyed out if Show Tics is 
set to No.



Conditional Bitmap Display Item

This display item has input capability.    It accepts a value between zero (()) and seven (7) 
from a strategy block, each value providing    capability to select a bitmap file to be 
displayed during Runtime.    When this display item is double-clicked upon, a dialog box will 
appear displaying all bitmaps currently installed.    

CONDITIONAL BITMAP DISPLAY ITEM DIALOG BOX

Bitmap File Name
Specify the Bitmap file to be selected corresponding with the currently highlighted Input 
Value. Enter the full path, or Browse to locate the desired Bitmap file.





Alarm Log Block

This block has input and output capability. The block allows Alarm data    from inputs to be 
logged to the GENIE Event Log File and to be displayed and acknowledged during runtime 
via the Event Viewer (\GENIE\GENIE.ELF) when the input data falls within the following 
regions:

1)    If the input data is above the high-high value
2)    If the data is between the high and high-high value
3)    If the data is between the high and low value
4)    If the data is between the low and low-low value
5)    If the data is below the low-low value

The block also outputs a value depending on what data is seen by the block.    For the 
following regions (regions anotated above):

1)    The block outputs a four (4)
2)    The block outputs a two (2)
3)    The block outputs a zero (0)
4)    The block outputs a one (1)
5)    The block outputs a three (3)

The Printer On checkbox allows you to print one line of output (same output as event log) for each alarm 
condition to the currently configured printer.    NOTE:    Only dot matrix printers are supported.

Event Log Viewer/Alarm Acknowledgement Dialog Box

While the strategy is running, alarms may be acknowledged by double-clicking on the Alarm Log Event 
(ALOG1 HI, etc. below). Alarms will be in the color red until acknowledged. For the Event Log dialog box 
to appear during Runtime, you must enable it via the View Menu. 



 Bar Graph Display Item

The Bar-graph display item displays output data from the strategy editor icon block during runtime in the 
form of a bar-graph. The bar-graph may be drawn and interfaced to a Strategy Block variable with a 
certain tag name. The color and size of the bar graph may be chosen. When in associated configuration 
dialog box (double-click on the bar-graph), you must first choose which Strategy Editor block's data you 
would like to display. Available icon blocks are displayed in a list box labeled "Input Block". The tagged 
block's dynamic value is displayed during runtime. You can choose the bar's color, the range, the 
orientation (vertical or horizontal), and the style of the bar graph. The style section is a series of check 
boxes allowing you to choose whether you see an outer frame, bordered bar, or whether or not you want 
numbers or tick marks to be displayed.



 YT Graph Display Item

For the YT Trend graph, you can choose the colors and the ranges that will be displayed. You next need 
to choose which Strategy Editor block's data you would like to display, corresponding with your chosen 
trace colors. Available icon blocks are displayed in a list box labeled "Input Blocks". Any number of blocks 
can be interfaced for display in one graph (however, 8 seems to be the practical limit). By double-clicking 
on each desired icon block tagname,    tagnames are selected for graphical display. When blocks are 
selected, an asterisk appears to the left of the tagname.    As you select tagnames for display, you can
choose separate trace colors for each tagname. The color for a trace is displayed and can be changed 
each time a selected tagname is highlighted with the mouse. You can also change the style of your graph.
The style section is a series of check boxes allowing you to choose whether you see an outer frame,    or 
whether or not you want numbers or tick marks to be displayed.

The Update rate is a divisor which allows the YT Trend Graph Display item to have a different effective 
scan rate than the rest of the strategy.    This is useful if, for example, your strategy is running at 100Hz, 
but you only want to display data at a rate of 20Hz.    For this example, you would set the Update Rate to 
5 (100 divided by 5 (the update rate) gives an effective scan rate of 20Hz). For this example, only one in 
five samples would be displayed; the others would be ignored.    Using the update rate option in this way 
will alleviate a flickering effect when using a very fast scan rate.

Note:    Keep in mind that when using an X-axis with a large scale (i.e. long time spans), and especially if 
you are displaying more than one trace, that machine memory requirement becomes large.    All data 
points that are displayed must reside in memory; the more data points you display, the more memory you 
will need.



 LED Indicator On-Off Display Item

An LED indicator, displaying the output state of a tagged digital block,    may be simulated here by 
specifying a digital    tag name from the Strategy Block variable. A digital 1 turns on the indicator and a 0 
turns it off. The color and size of the indicator may be chosen.



 Numeric/String Display Item

The numeric display item displays output data from the strategy editor icon block during runtime.
A numeric/string display may be drawn and interfaced with a Strategy Block variable with a certain tag 
name. The size of the display may be chosen. You choose whether the data is floating point (real), 
integer, or string, and the display format -- how many digits and location of the decimal point (for floating 
point format).    In addition, you can choose the font, size and color of the numbers or text to be displayed. 
Justification is also possible.

The Update rate is a divisor which allows the Numeric/String Display block to have a different effective 
scan rate than the rest of the strategy.    This is useful if, for example, your strategy is running at 100Hz, 
but you only want to display data at a rate of 20Hz.    For this example, you would set the Update Rate to 
5 (100 divided by 5 (the update rate) gives an effective scan rate of 20Hz).    For this example, only one in 
five samples would be displayed; the others would be ignored.



Anameter (Analog Meter) Display Item

The Anameter display item displays output data from the strategy editor icon block during 
runtime in the form of an analog meter. The Anameter may be drawn and interfaced to a 
Strategy Block variable with a certain tag name. The number, color and size of the color 
segments may be chosen. When in the associated configuration dialog box (double-click on 
the Anameter), you must first choose which Strategy Editor block's data you would like to 
display. Available icon blocks are displayed in a list box labeled "Input From". The tagged 
block's dynamic value is displayed during runtime. You can choose the segment color, range,
orientation (vertical or horizontal), and the initial value Anameter. Up to five segments can 
be specified. The style section is a series of check boxes allowing you to choose whether you
see an outer frame, bordered bar, or whether or not you want numbers or tick marks to be 
displayed.

ANAMETER DIALOG BOX

Show Tics
Specify whether Tics will be displayed.

Start Tics
Specify the    Tics start number.

End Tics
Specify the    Tics ending number.

Number of Tics
Specify how many total Tics

Meter Span
Specify the total numeric span of the meter.

Orientation
Specify the meter orientation -- Up, Down, Right, or Left.

Initial Value
Specify the value to which the meter needle will point upon Runtime Startup.

Number Of Segments
Specify the total number of color segments (up to five) for the span of the meter.



Segment 1-5 Start, End, and Color
For each enabled meter segment, specify the numeric start, end,    and color of the meter 
segment.





I/O Device

An I/O device is a hardware device capable of data input and output. Generally, this would 
encompass Analog to Digital Conversion (A/D), Digital to Analog conversion (D/A), and 
Digital Input and Output. The devices capable of such I/O can be in the form of plug-in I/O 
cards and/or remote devices. The I/O device's hardware should be configured (if necessary) 
first, and then the software can be configured to match the hardware's settings. Some I/O 
devices can be configured directly through the software's settings. Check your hardware 
manufacturer's manual for how to configure the hardware. After any hardware configuration 
is done, the software configuration can be set up by use of the Advantech Device Installation
Program, as long as a device driver has been previously installed using the DRIVERS 
program in the CONTROL PANEL (Main Window).



Install

To install a device means to:

1) Install its device driver in WINDOWS, using the device DRIVERS installation utility 
provided in the Control Panel, Main window.

2) Once the driver is installed, devices of the driver's type ( instances) may be installed (set 
up or configured), and added by using the Advantech Device Installation Program.    



Remove

To remove a device means:

Once the driver is installed, devices of the driver's type (instances)    may be removed, by 
highlighting the listing in the dialog box of the Advantech Device Installation Program and 
pressing the remove button. 

To remove the driver means:

Remove the device's driver from WINDOWS, using the device DRIVERS utility provided in the
Control Panel, Main window. 



Add

To add a device means to increase the number of I/O devices of the same type as the 
installed device driver. When a device is added to the system, only one driver is installed 
(using the device DRIVERS utility provided in the Control Panel, Main Window). Configuration 
information is then added by using the Advantech Device Installation program.    You may 
use more than one I/O device of    the same type installed in a system at one time. To add an 
I/O card, for instance, you would press the ADD button in the Advantech Device Installation 
Program and then configure the base address, and possibly other parameters. 



Setup 

To set up an I/O device is to set the parameters for use with the software the same as the 
settings of the actual I/O device. The values set in the device-specific dialog box should 
reflect those of the switches and jumpers you have set on the I/O device, board, or card. 
Alternatively, if you are using a software programmable device,    the device can be 
configured directly through the device-specific dialog box (in most cases).



Configure

To configure an I/O device, is to set the parameters for use with the software the same as 
those set on the actual I/O device. The values set in the device-specific dialog box should 
reflect those of the switches and jumpers you have set on the I/O device, board, or card. 
When an instance of a device is added, it must be configured before it can be used with the 
software.



Instance

An instance of an I/O device is a device that has been added and configured uniquely. For 
instance, there may be three Advantech PCL-818 multi-I/O cards installed in a system. Each 
PCL-818, installed at separate base addresses and having different parameters configured 
for each, is an "instance" of the PCL-818 driver (DLL)    that was installed in WINDOWS.



Actuator

A device that activates process control equipment by using pneumatic, hydraulic, or 
electronic signals. For example, a valve actuator is used to control fluid rate for opening and 
closing valves.



A/D Converter

Analog-to-digital converter. A circuit or device used for producing a set of digital output 
signals representing the magnitude of a voltage applied to its input. The resolution of the 
device is proportional to the number of its digital output bits. For instance, a 16-bit A/D 
converter is higher in resolution than a 12-bit A/D.      



D/A Converter

A device that converts digital information from the computer into a corresponding analog 
voltage or current. This allows the computer to control real world events. Analog outputs 
may directly control equipment in a process that is then measured by an analog input. It is 
possible to perform closed loop or PID control with the D/A function. Analog outputs can also 
generate wave forms (function generator). The resolution of the device is proportional to the
number of    its digital input bits. For instance, a 16-bit D/A converter is higher in resolution 
than a 12-bit D/A.      



Analog

In electrical quantities, having the property of varying in a continuous, rather than 
incremental or discrete-step manner.



C, Centigrade, Celsius

Zero degrees = Freezing and 100 degrees = Boiling point of water at sea level.



CJC, Cold Junction Compensation

If two wires of different metals are connected end to end, there are two junctions formed. 
Current will flow in the resulting circuit if one junction is at a different temperature than the 
other (Seebeck Coefficient). This effect is the same for either junction except for polarity. Call
one of the junctions the measuring junction. Separate the other junction and connect the 
two leads to a current meter. When making temperature measurements, if the current 
produced by this other junction (cold junction) is ignored, an unknown error is created. If the 
temperature of the cold junction is noted at the same time as a measurement is made, then 
the error from the cold junction can be added or subtracted from the reading to give a 
correct answer.

Automatic cold junction compensation is accomplished by sensing the terminal temperature 
(cold junction) with an RTD. The RTD is in a circuit which produces a current equal and 
opposite to that produced by the cold junction. Thus the current change from the cold 
junction plus that from the compensation circuit cancel one another. Once this is 
accomplished then it can be assumed that the current meter reading represents the current 
produced by the measuring junction only. 



Comp Loop
An extra pair of wires going to the tip of an RTD but not connected to the element, a novel 
way of lead wire resistance compensation.



Controller, Temperature
A device or software program capable of receiving a signal from a temperature sensing 
probe within a process and regulating an input to that process in order to maintain a 
selected temperature (control point).



Conversion Rate

The number of analog-to-digital (A/D) conversions (samples) performed per second.



Counts

The number of    events, or events counted by the event counter. The event counter 
increments or decrements whenever a rising edge of a digital signal is sensed at the counter
input.



Deadband (Hysteresis)

In a digital (on/off) controller, there may be one switching point at which the signal increases
and another switching point at which the signal decreases. The difference between the two 
switching points is called hysteresis or deadband. 



Differential Input

A signal-input circuit where SIG LO and SIG HI are electrically floating with respect to analog 
ground (I/O device analog ground, which is normally tied to digital ground). This allows the 
measurement of the voltage difference between two signals tied    to the same ground and 
provides superior common-mode noise rejection.



F (Fahrenheit)

32 degrees = Freezing and 212 degrees = Boiling point of water at sea level.



Hold

An external input which is used to stop the process (event counter, A/D, etc.) temporarily, 
freezing the device's output at the current value.



Hz

Frequency in cycles per second, pulses per second, events per second, etc.



Impedance

Resistance to electrical flow in an AC circuit. It is designated by the symbol Z and is 
expressed in ohms.                                                                                                                                                         



Input Resistance

Resistance measured across the input terminals with the signal leads disconnected.



K (Kelvin)

The basic temperature unit of the thermodynamic scale, symbol K. 1/273.16 of the 
thermodynamic temperature of the triple point of water.    Zero    degrees    K    =    zero    
degrees    C    - 273.16.



Measuring Junction

That junction of a thermocouple subjected to the temperature to be measured.



Multiplex

A technique which allows different input (or output) signals to use the same lines at different
times, controlled by an external signal. Multiplexing is used to save on wiring and I/O ports.



Overshoot

The ratio of the over-travel of the output of a controller beyond a new steady state to the 
change in steady state when a new constant value of the measured quantity is suddenly 
applied (step input).



Range

The span of values over which a device will function without entering an overload condition.



Reference Junction

The other junction (usually at ice point) to which the measuring junction thermocouple 
junction is compared. The output voltage of a thermocouple is approximately proportional to 
the temperature difference between the measuring (hot) junction and the reference (cold) 
junction.



Resolution

The degree to which nearly equal values of a quantity can be discriminated. In analog 
devices, the difference between the values represented by two adjacent    divisions. In digital
values, the value represented by a one-digit change in the least-significant digit.



Response Time

The time necessary for a device (sensor, A/D, D/A) to reach 63.2% of a step change in 
measured quantity (temperature, voltage, etc.)



RTD

Resistance Temperature Detector -- sensor, bulb, transducer; precision winding of copper, 
nickel, balco (nickel-iron), platinum (industry standard), or tungsten element used for 
temperature measurement. Connected via 2, 3, or 4 wire hook-ups.



Secondary junction

An unwanted connection between a pair of thermocouple wires tending to produce a signal 
representative of the secondary junction temperature rather than the measuring junction 
temperature.



Settling Time

The time taken for the display to settle within one digit final value when a step is applied to 
the A/D input.



Signal Conditioner

A circuit module which offsets, attenuates, linearizes, or filters the signal for input to the A/D
converter. The typical output span of a signal conditioner is +/- 5VDC.



Single Ended Input

Amplifier with one input referenced to ground.



Temperature Limit

The full capability of the system from the lowest point to the highest point: limited by the 
sensor.



Temperature Span

Those two points anywhere within the temperature limit to which the signal 
conditioner/amplifier can be calibrated. FORMULA: Maximum temperature - minimum 
temperature = span.



Temperature Stability/Instability

The unwanted change (error) of an instrument, sensor, amplifier, etc. caused by changes in 
the temperature surrounding it. Usually expressed as the total change between two 
temperature limits, or % error/degree C or F.



Thermocouple

Two dissimilar metals with a voltage output proportional to temperature. ANSI types:

Type        Composition                                Max Degrees F  
J Iron-Constantan 2192
K Chromel-Alumel 2501
T Copper-Constantan 752
E Chromel-Constantan 1832
R Platinum-Plat.13%Rhodium 3214
S Platinum-Plat.10%Rhodium 3214
B Plat.6%Rhod.-Plat.30%Rhod.3308
C Tu 5%Rhenium-26%Rhenium 5000



Thermocouple Break Protection

A safety feature to indicate when a thermocouple has failed in an open circuit condition. Its 
purpose is to eliminate the possibility of an ambiguous reading. In the case of a temperature
controller, it eliminates the dangerous condition of thermal runaway.



Transducer

A device which converts temperature, pressure, level, length, position, etc. into a voltage, 
current, frequency, or pulses, etc.



Wheatstone Bridge

A full resistance two (2) wire bridge with RTD, power source, zero and sensitivity 
adjustments balanced at some reference temperature. Heating or cooling causes a 
resistance change and discrete circuit unbalance, which indicates the temperature. Various 
RTD bridge network connections use 2, 3, or 4 wire hook-up arrangements, depending on 
the accuracy required in the temperature measurement. These are designed to balance out 
lead wire resistance between the sensor and the bridge. Accuracy obtained is usually:

2 wire +/- >=0.5% (0.5-50 degrees C)
3 wire +/- >=0.25-0.5% (0.25-0.5 degrees C)
4 wire +/- >=0.15-0.25% (0.1-0.25 degrees C)






